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Warnings, Cautions, and Notes
as Used in this Publication

Warning notices are used in this publication to emphasize that
hazardous voltages, currents, temperatures or other conditions that
could cause personal injury exist in this equipment or may be
associated with its use.

In situations where inattention could cause either personal injury
or damage to equipment, a Warning notice is used.

Caution notices are used where equipment might be damaged if care is
not taken.

Note

Notes merely call attention to information that is especially significant to
understanding and operating the equipment.

This document is based on information available at the time of its publication.  While
efforts have been made to be accurate, the information contained herein does not
purport to cover all details or variations in hardware or software, nor to provide for
every possible contingency in connection with installation, operation, or maintenance.
Features may be described herein which are not present in all hardware and software
systems.  GE Fanuc Automation assumes no obligation of notice to holders of this document with
respect to changes subsequently made.

GE Fanuc Automation makes no representations or warranty, expressed, implied, or
statutory with respect to, and assumes no responsibility for the accuracy, completeness,
sufficiency, or usefulness of the information contained herein.  No warranties of
merchantability or fitness for purpose shall apply.

The following are trademarks of GE Fanuc Automation North America, Inc.

Alarm Master CIMSTAR Helpmate PROMACRO Series Six
CIMPLICITY GEnet Logicmaster Series One Series 90
CIMPLICITY 90 – ADS Genius ModelMaster Series Three VuMaster
CIMPLICITY Power TRAC Genius PowerTRAC ProLoop Series Five Workmaster

The following are trademarks of Horner Electric, APG, LLC.

Cscape SmartStack CsCAN

 Copyright 2000 GE Fanuc Automation North America, Inc.
All Rights Reserved

Warning

Caution
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ABOUT PROGRAMMING EXAMPLES

Any example programs and program segments in this manual or provided on accompanying diskettes are
included solely for illustrative purposes.  Due to the many variables and requirements associated with any
particular installation, GE Fanuc cannot assume responsibility or liability for actual use based on the
examples and diagrams. It is the sole responsibility of the system designer utilising the Operator Station
to appropriately design the end system, to appropriately integrate the Operator Station and to make
safety provisions for the end equipment as is usual and customary in industrial applications as defined in
any codes or standards which apply.

NOTE: The programming examples shown in this manual are illustrative
only.  Proper machine operation is the sole responsibility of the system
integrator.

DECLARATION OF EMC CONFORMITY

Manufacturer's Name: Horner Ireland Ltd.
Manufacturer's Address: Unit 1, Centrepoint, Centre Park Road, Cork, Ireland

Declares that the products Models: IC300TIU101, IC300TIU111, and IC3500TIU201
Conforms to the following EMC standards:

EMC: EN 55 022, Radiated and Conducted Emissions
EN 50 082-1, RF, EFT/EFB, ESD Immunity

Supplementary Information:

The above conformity only relates to the products in a stand-alone capacity.  The products are used as
part of a system and are therefore classified as a component.  As a component, the products are
prohibited by EC regulations to carry a CE Mark for EMC conformity.  Static discharge tests only apply to
normal operation of the keyboards via the front panel.  We would stress that the use of our products
within your system, while helping to ensure compliance of your system to the same directives, do not
necessarily guarantee that compliance will be achieved.  We would also like to point out that the
interpretation of the law concerning CE marking and its application to sub-assemblies and components is
open to interpretation.

Date: 31 Mar 1999
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CHAPTER 1: INTRODUCTION

1.1 Scope

CBREEZE is a easy-to-use Windows -based software. The software user’s guide is contained in this
manual.  (See Section 1.4 for initial software installation procedures.)

A basic level of understanding of Microsoft Windows technology and operation is assumed. The manual
assumes that the user is familiar with Windows 95, Windows 98 or Windows NT.

Contact your dealer for more information.

Note: The Help File in the Software contains similar information to this manual.

1.2 Equipment Needed

a) Software Installation CD.
b) A PC Windows 95 , Windows 98  or Windows NT .
c) Approximately 15.7 MB of available hard disk space.
d) TIU050/10X/11X/20X Interface Unit.
e) PC to TIU Programming Cable HE693CBL232 or equivalent (Operator Station Hardware Manual

GFK-1819).

Software Installation Instructions

a) Start your Windows  Operating System.
b) Insert the Software Installation CD.
c) The Software should begin installing automatically, if not continue to next step.
d) Click the Windows Start menu button and then click Run.
e) The Run dialog box appears.
f) Type D:\setup (CD Drive letter assumed to be D:).  Click OK.

1.3 Upgrade Revision Software & Firmware

1.3.1 General
To avail of any new features that are included in this new release on units that were purchased previous
to this release, both software and firmware require updating by the user. Any new unit will be set-up for
the latest version released.

1.3.2 Software Upgrade
To update the software requires that the user install the new version of software from the installation CD.
You may install the new software over any previous version installed. See section 1.4 Software
Installation Instructions.
To update existing projects simple open the project from the newly installed version of the software. Once
the project is saved to disk the update is complete. For backup reasons we recommend that you save the
new version of your project in a different location or under a different file name.

1.3.3 Firmware Upgrade
The following steps assume that a project or configuration is loaded to the Operator Station and that the
user is running the latest version of software.

a) Upload the project/configuration from the unit.
b) If a customised character set is loaded to the unit then upload the character set also.
c) Choose AE from main menu Configure/Communication Settings.



PAGE 10                                                         06 Apr 2000                                 CH. 1:  INTRODUCTION
GFK-1818

d) From File menu choose Update TIU Operating System. (See Updating Operating System for more
details).

e) From File menu choose Update TIU Protocol. If you are updating from firmware version 2.00 or later
then you just have to update to the latest protocol file. However if you are updating from firmware
version 1.24 or earlier you most update to a Upgrade.1xx protocol file first, then update to the latest
firmware revision. See Note. (See updating protocol for further information).

f) Choose Download Character Sets to TIU from File menu.
g) Choose Download Project to TIU from File menu.

Note: When updating the operating system file the screen may go blank after the protocol file is
complete. Continue with the procedure as described and the display will recover.
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CHAPTER 2: GETTING STARTED

2.1 Self-Test
Power up the unit with the UP and ENTER keys pressed at the same time.  The unit enters a self-test
mode. The self-test consists of the following four checks:

2.1.1 Contrast Band
This test allows the user to set the lower and upper limits of contrast.  Adjust the lower limit using the UP or DOWN
key and press Enter when done.  Do the same for the upper limit.

Note: Self test - The contrast band adjustment is only available on Tiu1xxs.

2.1.2 Display Test
The display test continuously blinks all pixels on (black) to off.  Look for any pixels stuck on or off.  Exit
this test by pressing and holding any key for approximately two seconds.

2.1.3 Keyboard Test
As each key is pressed, an indication *** appears above that key. In the case of units with a numeric
keypad, press the key and a message appears indicating the key press.  Check for keys indicating
multiple presses or not reporting presses.  Exit this test by pressing and holding any key for
approximately two seconds.

2.1.4 RAM Test
Test either segment 0000 or segment 1000 (on the TIU100/110) of the RAM.  The segment 1000 test
performs a base 3 repeating test.  This test detects shorted address lines and damaged memory bits.
The segment 0000 test performs a Read-Modify-Write test on each byte of RAM, detecting damaged
memory bits.  Exit this test by selecting DONE.

2.1.5 Serial Loop-back Tests
Tests the PC port and the Serial Port in each of it’s three modes for serial loop-back.  Pre-made plugs are
required to link the pins of a particular port. This takes the following form:

Table 7.1 Loop-back Test Plugs
Port Tested Product Type of Connector Pins to Short

PC (J2) TIU100/110 Pin male D link connector pin 2 to pin 3
RS-232 (J3) TIU100/110 13-pin phoenix connection pin 6 to pin 8
RS-422/485 (J3) TIU100/110 13-pin phoenix connection pin 2 to pin 4 and pin 3

to pin 5.
Current Loop TIU100/110 13-pin phoenix connection pin 1 to 9, pin 10 to 11

and pin 12 to 7
PC TIU050/101/102/1

03/111/112/113/20
0/201/203

Pin male D link connector pin 2 to pin 3

RS-232 TIU050/101/102/1
03/111/112/113/20
0/201/203

8-pin phoenix connection Pin 5 to pin 7

RS-422/485 TIU050/101/102/1
03/111/112/113/20
0/201/203

8-pin phoenix connection Pin 1 to pin 3, Pin 2 to
pin 4

NOTE: current loop in not installed on standard models, as such a standard model will fail the
current loop-back test. Current Loop is not an option on the
TIU050/101/102/103/111/112/113/200/201/203.

After starting the test, the OK counter begins to count up.  Exit this test by selecting DONE.
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2.2 Selecting the Automation Equipment (AE)

The following points are covered in this section:

a. Connecting a PC to the TIU050/10X/11X/20X;
b. Choosing the AE connected to the TIU050/10X/11X/20X
c. Selecting the protocol to be used.

1. Install the CBREEZE software on your PC (if not already done).  Double-click on CBREEZE Software
icon; and the default screen shown below appears.

2. From Configure, pick Select Terminal Type and choose the model.

3. Connect the TIU050/10X/11X/20X (PC Port) to a serial port (COM1, 2, 3 or 4) on the PC.  From the
Configure menu, choose PC Comms Port and the applicable Comm port.

4. Connect power (+24VDC) to the TIU050/10X/11X/20X.  Power-up the unit.  The type of protocol
currently installed is displayed in the lower half of the screen during power-up.

5. If the AE is different than the protocol currently installed on the TIU050/10X/11X/20X, a new protocol
must be loaded.

Figure 2.1 - Default Screen
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6. From the Configure menu, click Communication Settings and select manufacture of the AE,
followed by the type.  The default setting for this equipment will be displayed in the window. Click OK
to accept.

7. If the default setting does not match the communications settings of the AE, select the appropriate
Baud Rate, Parity, Data Bits, Stop Bits and Communication Mode.  Also, if applicable, enter the
appropriate Target Node ID.  See figure 2.2.

Note: If connecting the TIU to a number of devices on the AE port (i.e. a multidrop system) then the
Network mode enable box should be ticked, and the node id required will need to be entered whenever
an automation equipment reference is required.
Note: If connecting the TIU to a single device on the AE port then the network mode enable box should
be unticked and the node ID for the single device entered as the global remote ID. All references to AE
equipment registers will now assume the global remote ID number entered here.

Figure 2.2 – AE Configuration Box

Same as PLC ID



PAGE 14                                                         06 Apr 2000                           CH. 2: GETTING STARTED
GFK-1818

To update the protocol, select File, then Update TIU Protocol. The protocol file names take the general
form: - {plc_type}_r{release number}.{ser}
Where AE type is a prefix dependent on the protocol, release number is currently 4 and {ser} is 0xx for
Tiu050, 1xx for Tiu1xx and 2xx for Tiu2xx.

Note: Prior to release 4, protocol file names were of the form: - {plc_type}.{type} where type was LOS for
Tiu050 BOS for Tiu1xx and GOS for Tiu2xx. Dependant on the protocol and terminal type selected the
standard windows file open box will be displayed with the filename selected accordingly. Select the
protocol file you wish to download.

The appropriate protocol file for previously selected the automation equipment will be displayed in the file
name window. Select the folder name for the appropriate terminal type (0xx for Tiu050, 1xx for Tiu1xx
and 2xx for Tiu2xx). Click OK.  A “SYSTEM SHUTDOWN” message appears on the
TIU050/10X/11X/20X.

2.3 Proving Communications

Connect the TIU050/10X/11X/20X to the automated equipment using the cable drawing provided.

Figure 2.3 – Start-up Menu
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The following steps verify communications between the TIU050/10X/11X/20X and the automation
equipment.  The figures shown here are for the TIU100.  Methods are exactly the same for the all
products in the TIU range.

1. Click on the Wizards Icon  in the tool bar and choose Comms Stats. The display should then
look like figure 2.3.

Note: The TIU050/10X/11X/20X only communicates if an embedded data is put on the screen

2. The settings can be saved.  To do this, select Save Project As from File.  Enter a file name and click
OK.

3. Download the project to the TIU050/10X/11X/20X.  To do this, from the File menu select Download
Project to Tiu.  A status bar appears indicating the progress of the download.  On the
TIU050/10X/11X/20X Display Screen, “SYSTEM SHUTDOWN” appears.  A message of “Transfer
Complete” appears when the data has been successfully downloaded.

Note: If the error “Link Failed” appears, check the cable connection between the PC and
TIU050/10X/11X/20X.

4. After the transfer, the TIU050/10X/11X/20X resets itself and the correct automation equipment type is
shown temporarily on the Display Screen.

5. On the Display Screen, the “GOOD” number of communications should be equal to the “TOTAL”
number of communications.  The content of the embedded data, on the top line, depends on the
existing data in that register of the PLC.

2.4 Icon Descriptions

The TIU050/10X/11X/20X software main screen is shown in Figure 2.4.  Along the top are several short
cut icons.  Many are standard Windows  icons, some however, are special function.
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2.5 Up/Down Keys

Left clicking on the “Up” and “Down” keys on the project window has the same effect as “Up” and
“Down” key presses (i.e., scroll up/down through the current menus).  Right clicking on the “Up” and
“Down” keys on the project window have the same effect as Ctrl-Page Up and Ctrl-Page Down key
presses (i.e., enter sub menu, and leave sub-menu, respectively). If a sub-menu does not exist a
message appears saying “This page does not have a sub-menu, would you like to create one?” See
Creating a sub-menu later in this manual.

2.6 Key Symbols

The symbols for the four keys can be added to display pages using the PC function keys F2-F5.  The
keys are assigned as follows:
1. F2 = PAUSE
2. F3 = UP
3. F4 = DOWN
4. F5 = ENTER

Figure 2.4 – TIU050/10X/11X/20X Software Screen



CH. 3: ABOUT PROJECTS                             06 Apr 2000                                                         PAGE 17
GFK-1818

CHAPTER 3: ABOUT PROJECTS

3.1 Scope

This chapter describes the procedure for configuring the TIU050/10X/11X/20X.  This includes loading,
saving, downloading, uploading, verifying and updating the protocol.

3.2 About TIU Terminal
This new feature allows the programmer to see what version level the connected terminal is at and how it
is configured. The information give is;
a. Operating System Version Level
b. Firmware Version Level
c. Protocol Version Level
d. Remote Equipment Manufacture
e. Remote Equipment Model

This can be used as a useful diagnostic tool when updating operating system and firmware. From the
main menu click Help/About TIU Terminal, a window similar to Figure 3.1 appears.

3.3 Creating a New Project
1. Select New from the File menu.
2. The following prompt window appears:

3. Click OK.

Figure 3.2 – New Project

Figure 3.1 About TIU Terminal Configuration
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3.4 Opening a Project
1. Press the “open folder” icon on the program display screen or select Open Project from the File

menu.
2. Select the proper file name from the list of available projects (with “cmc” extension).
3. Click OK.

3.5 Saving a Project
1. If the project has been previously saved during the current session, press the “floppy” disk icon on the

program display screen or select Save Project from the File menu
2. If this is the first time saving this project to a file, select Save Project As from the File menu.
3. Enter the file name and destination.  Click OK.

3.6 Downloading a Project
Prior to the download the software checks if following conditions are correct: -
a) The correct TIU terminal is connected to the PC.
b) The correct Protocol file is loaded to the terminal.
c) The current revision operating system and firmware revision.

Note: If the message “Link Failed” appears, check the cables connecting the PC to the unit.

Note: If the message “This Terminal is fitted with the incorrect PLC protocol. Load the correct protocol
before loading the configuration into the terminal”. The project and the terminal are not set-up for the
same protocol. If the project is correct then download the correct protocol file to the TIU.

1. Select Download Project from the File menu.  A status bar appears; indicating the download is in
progress.

2. After the project has been downloaded, the message “Transfer Complete” appears.
3. After the transfer, the TIU050/10X/11X/20X resets itself.
4. The downloaded project now runs.

3.7 Uploading a Project
1. Select Upload Project from the File menu.
2. A status bar appears; indicating the upload is in progress.

Note: If the message “Link Failed” appears, check the cables connecting the PC to the unit.

3. After the project has been uploaded, the message “Transfer Complete” appears.

3.8 Verifying a Project
1. Select Verify Project from the File menu.
2. A status bar appears indicating verification progress.
3. The Verify will stop at all reported errors
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3.9 Updating the Protocol
When the software is installed the user decides where the main CBREEZE folder resides. During
installation the following folders are created: -

In the protocol directory 3 folders are created, TIU0xx, TIU1xx and TIU2xx. The protocol files for the
different terminal are loaded into these folders. The protocol files for the TIU050 are loaded into Tiu0xx,
the protocol files for the TIU10X are loaded into Tiu10x and the protocol files for the TIU20X are loaded
into Tiu20x.
The name of the protocol file is broken up into three sections, the protocol, the main software revision and
the terminal type that protocol file is for.

Example
snp_R4.1xx
This is the protocol file for release 4 software for the GE FANUC PLC, for the TIU10X
df1_R4.2xx
This is the protocol file for release 4 software for Allen Bradley PLC, for the TIU20X

To Update Protocol File
1. Set Terminal Type
2. Set the required Automation Equipment in Communications Settings
3. Select Update TIU Protocol from the File menu.
4. Select the folder of the terminal you have connected to the PC. The correct file will appear for the

terminal type selected and the Automation Equipment selected. Select that file and click OK.
5. A status bar appears indicating download progress.
6. After the transfer, the TIU050/10X/11X/20X resets itself.  The correct PLC type is displayed on the

TIU050/10X/11X/20X.
7. Next, the project loaded runs.

3.10 Updating the Operating System
1. There is a different operating system file for each terminal type. Therefore select terminal type first

and the software will request the correct file name for the current terminal type selected.
2. Select Update Operating System from the File menu.
3. Choose the updated file with the “BIN” extension. The operating system files are stored in the OS

folder under the CBREEZE folder. Only the correct file name will be displayed. Click OK.
4. A status bar appears indicating download progress.
5. During the download process, TIU050/10X/11X/20X displays the message “SYSTEM SHUTDOWN”.

Protocol Name _ Software Revision . Terminal Type
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3.11 Printing

The software has printout capability.  To print, select Print from the File menu or click on the Print icon.
The system parameters (# of menu pages, # of alarm pages, # of status pages, PLC type, port settings,
communication configuration, and PLC station number) and all of the pages are printed.

The printer set-up is selecting Printer Setup from the File menu.  The printer set-up screen is shown in
Figure 3.3.

3.12 To Insert a New Page

1. Click on the Insert Page Icon or from Edit choose Insert Page.
2. Pages can either be Insert After Current Page or Insert Before Current Page.  Also, select the

number of pages to be inserted.  Click OK.

3. If the user goes to the last page of the project and clicks on the down key the a messages appears
saying “There are no more pages in this menu, do you want to create some?” If the OK button is
pressed the above insert menu pages appears.

3.13 Default Page Type
(TIU20X Only)
With the TIU20X series there are two types of pages.
a. Text Page
b. Graphic Page

The CBREEZE Software may be set-up to create either type of page by default or alternatively the
software can be set up to display a prompt asking which type page is to be created every time a page or
pages is inserted. (Prompt On Page Creation).

Figure 3.3 – Printer Set-up Box

Figure 3.4 – Insert Pages Message
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Text Page
A text page in the TIU20X is similar to the normal page created with the TIU10X/11X, i.e. the same
functions that are available on the TIU10X/11X are also available on a Text Page of the TIU20X. To use
the extra graphic features of the TIU20X a Graphic page must be created.

Graphic Page
A graphic page can be used to display all the features of the Text Page plus the extra features available
for a Graphic Page. See chapter on Graphic Editor for further details of features available.

3.14 Download/Upload Character Set (Not available with the TIU050)
After new characters have been created with the character generator, these characters must be
downloaded to the TIU.  Conversely, an existing character set in the TIU can be uploaded.

3.14.1 To Download a Character Set:
1. Select Download Character Set to TIU from the File menu.  A status bar appears; indicating the

download is in progress.

Note: If the message “Link Failed” appears, check the cables connecting the PC to the unit.

2. After the project has been downloaded, the message “Transfer Complete” appears. The new
character set is now loaded to the TIU.

3.14.2 To Upload a Character set from the TIU:
1. Select Upload Character Set from the File menu.
2. A status bar appears; indicating the upload is in progress.
3. After the project has been uploaded, the message “Transfer Complete” appears.

3.15 Select Terminal Type
This software package supports the project of multiple Operator Stations (TIUs).

3.15.1 To select the Operator Station Terminal Type:
1. From Configure, pick Select Terminal Type and choose the model.
2. Choose the model or TIU being used. The screen changes to show the model just selected.

3.16 Delete a Page
1. Go to the page to be deleted.  Click on the Delete Page icon or from Edit choose Delete Page.
2. The current page is deleted and the next page is displayed.

3.17 Font Size (Not available with the TIU050)
There are four different Font Sizes: Normal, Double Height, Double Size (x2) and Four Times Size (x4).
The size of an entire line is set, individual words on a line cannot have a different size then other words.

3.17.1 To change/set the Font Size of a line:
1. Click somewhere on the line to be adjusted.
2. Click on the desired Font icon.  The size of the entire line is adjusted.  Any characters beyond the

right border of the screen are maintained but not displayed in the CBREEZE software or on the TIU.

3.18 Key Mapping
The keyboard can be mapped to PLC automation equipment along with the currently displayed page
number.  This enables keys to be used in Jog/Instantaneous action modes.  Sending the page number
allows the automation equipment to qualify the key states sent to ensure that the function only operates
on the correct page.  The page number is written to the specified data register, Page Mapping, and the
keys are mapped into the next contiguous data register, Key Mapping.
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3.18.1 To enable key mapping:
1. From the Configure menu, select Keyboard Mapping.
2. Check the Enable box.
3. Choose the Register Type and the Map Page To Register.  Click OK.

The Configure Key Mapping screen displays the data type, the active page number (from which the
keys are active) and the keyboard mapping bits.

3.19 Function Keys
The TIU050/10X/11X/20X support function keys to be assigned in the project. The Up, Down, Pause and
Enter key can be configured as function keys however are defined on a per page basis.  Due to the fact
that the keys may have other functions allocated to them the following restrictions are placed on the
allocation of functions to these keys:

1. The Pause key is available for mapping on status pages, alarm pages, and menu pages with no
editable embedded data, and which are not part of a submenu, and which do not have a submenu.

2. The Enter key is available for mapping on status pages, alarm pages and menu pages, except the
first menu page.

3. The Down Key is available for mapping on status pages and on the last page of a sub menu.
4. The Up Key is available for mapping on status pages and on the first page of a sub menu. (It is used

for scrolling purposes on menu pages that are not the first in a submenu, and on alarm pages.)

Along with the Up, Down, Pause and Enter keys, the alphanumeric keypad on the TIU050/11X/20X can
also be assigned functions in the CBREEZE software. These function keys can be programmed on all
page types and menus.

Figure 3.5 - Configure Keyboard Mapping Box
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The Configure Function Key Screen lists the available function keys on each page. See Figure
3.6.

Double Click on the key to be programmed. Each key maybe programmed as a Global or Local function
key. Programmed as a Local function, the key will only complete the function in the present page only.
Programmed as a Global function, the key will perform the function on every page of the project,
provided it is not overridden on a particular page with a local function.

Note: The Up, Down, Pause and Enter keys can only be programmed as Local Function Keys.

The Key Actions for both Local and Global are:
1. Disabled
2. Push Button
3. Preset Register
4. Display Page
5. Ramp Register
6. Set Bit
7. Clear Bit
8. Invert Bit
9. Execute Maths

Figure 3.6 Configure Function Keys for the TIU
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1. Disabled
Default setting, change to any other of the setting to enable function key.

2. Push Button
Sets the register chosen in the Location and Set Data type to the value in the Value field while the
button is pressed. The register is reset when the button is released.

3. Preset Register.
Sets the register chosen in the Location and Set Data type to the value in the Value field.

4. Display Page
Displays the specified page in the Page Number field.

5. Ramp Register
Increases the value of the Data Type or register type specified under the Location field by the value
entered in the Value field.

6. Set Bit
Sets the bit specified in the Bit field of the Location, of the Data Type or register type to “1”.

7. Clear Bit
Sets the bit specified in the Bit field of the Location, of the Data Type or register type to “0”.

8. Invert Bit
Toggles the bit specified in the Bit field of the Location, of the Data Type or register type.

9. Execute Maths
Executes mathematic function beginning at the specified line number.

Figure 3.7 Function Key Definition
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3.19.1 Function Key LEDs on TIU20X

Function Key F9 – F18 have corresponding LEDs above or below the function key, indicating if the
function is programmed or not. These LEDs light up when the corresponding Function Key is
programmed to execute a function. When the function key is programmed as a Global Function Key then
the LED is lit up constant as the user goes through the programmed menu screens, on the terminal.
When the function key is programmed as a Local Function Key then the corresponding LED is only lit
when the page in which the local function is programmed is displayed on the terminal.
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NOTES
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CHAPTER 4: EMBEDDED DATA

4.1 Scope
On the TIU050/10X/11X up to 8 embedded data fields may be placed on each page. On the TIU20X up to
64 embedded data fields may be placed on each page. Embedded data types are numeric (monitor or
editable), alphanumeric (monitor only on the TIU10X, editable on all other models), timer (monitor or
editable), bit status (monitor or editable), system variable (monitor only), password (entry only in
operation), Horizontal Fill, Text Selector, Recipe item, and Clock Calendar.  Many of the sections in this
chapter contain specific instructions that are intended to serve as examples only.

Note: If range checking is enabled, then increments and decrements are only allowed between the
maximum and minimum ranges.

There are 4 ways to embed data onto the screen.

a. Double click the Display window area.

b. Click the Embed Data icon 
c. Chose Edit/Embedded data from the menu.
d. Press Shift and Enter Keys together.

If you double click the display window area or click the Embed Data icon the following screen appears
(Fig 4.1). From this the programmer can pick which type of data they wish to embed.

Figure 4.1 – Chose Embedded Data Type
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4.2 Numeric Data
4.2.1 Scope
This section describes the Numeric Data functions available in the TIU050/10X/11X/20X.  Use the
instructions as follows to embed Numeric Data.
From the Embedded data list select Numeric Data, the screen shown in Figure 4.2 appears.

1. Select a Data Type (register or other) and enter a number for the Location (100 for example).

Note: For numbers 0-65535, use 16 Bit Unsigned format.  For numbers 0-999999999, use 32-Bit
Unsigned format.  When 32-bit is selected two contiguous registers are read from the AE if the AE
register specified is a 16 bit register.  The first register read contains the low word and the second register
contains the high word.  The data source register specifies the first of two registers. Where the AE
register is a 32 bit register, for example on A MOOG PSC100, only a single register is read.

2. If 16 Bit and Signed is chosen from Format, then numbers -32768 TO 32767 may be utilised.
3. The signed, 32-Bit format for numbers -999999999 to 999999999 may be selected by clicking on

32-Bit and Signed.

Figure 4.2 – Numeric Data Type Box
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4.2.2 To edit numeric data:
1. Check the Edit\Write box.
2. To enable range checking, check the Range Checking box and enter a Maximum and Minimum

range number (100 and 5 for example).

4.2.3 To change data registers contents from the TIU050/10X/11X/20X:
1. Press the Pause key to select the data field for editing. The selected field becomes highlighted.
2. To increment the data, press the Up key.
3. To decrement the data, press the Down key.
4. On Terminals TIU050/11X/20X the numeric pad may be used as an easier way to enter data.
5. To enter the data to the PLC, press the Enter key. If range checking is active, then increment and

decrement are only allowed between the maximum and minimum ranges.

4.3 Alphanumeric Data
4.3.1 Scope
This section describes the Alphanumeric Data functions available in the TIU050/10X/11X/20X.  Use the
instructions as follows to embed Alphanumeric Data.
From the Embedded data list select Alphanumeric Data, the screen shown in Figure 4.3 appears.

Figure 4.3 – Alphanumeric Data
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4.3.2 To embed alphanumeric data:
1. Select Data Type.  Enter a number for the Location (100 for example).
2. Enter the Number Of Characters to be displayed.  One character is a byte (8 bits).  To have 10

characters, five registers are read.

4.4 Timers
4.4.1 Scope
This section describes the Timer functions available in the TIU050/10X/11X/20X.  Use the instructions as
follows to embed Timers.

From the Embedded data list select Timers, the screen shown in Figure 4.4 appears.

Figure 4.4 – Timers
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4.4.2 To monitor Timers on the TIU050/10X/11X/20X.
1. Select a Data Type, and enter Location number.
2. Select a timer format under Format.  Table 6.1 shows the available timer format.  A 32-bit timer reads

two contiguous registers.
3. Check the Edit Enable box to allow for the editing of the time format.
4. Check the Range Checking box to enter a Maximum and Minimum range.
5. Range checking can be entered in SECONDS; MINUTES, SECONDS; or HOURS, MINUTES,

SECONDS.

4.4.3 To edit the data field:
1. While displaying the appropriate page, press the Pause key to select the data field for editing. The

selected field becomes highlighted.
2. To increment the data, press the Up key.
3. To decrement the data, press the Down key.
4. To enter the day to the PLC, press the Enter key.  If range checking is active, then increment and

decrement are only allowed between the maximum and minimum ranges.

Table 4.1 – Configurations for Timer Format
16-Bit MM:SS 12 Hour             Minutes & Seconds
16-Bit HH:MM:SS 12 Hour Hours, Minutes & Seconds
16-Bit MM:SS_T 12 Hour Minutes, Seconds & 10th of Seconds
16-Bit HH:MM:SS_T 12 Hour Hours, Minutes, Seconds & 10th of Seconds*
16-Bit HH:MM 12 Hour Hours &Minutes.
32-Bit MM:SS 24 Hour Minutes & Seconds
32-Bit HH:MM:SS 24 Hour Hours, Minutes & Seconds
32-Bit MM:SS_T 24 Hour Minutes, Seconds & 10th of Seconds
32 Bit HH:MM:SS_T 24 Hour Hours, Minutes, Seconds & 10th of Seconds
32-Bit HH:MM 24 Hour Hours &Minutes
* up to a maximum of 1:49:13.5

4.5 Bit Status
4.5.1 Scope
This section describes the bit status functions available in the TIU050/10X/11X/20X.  Use the instructions
as follows to embed Bit Status.

1. From the Embedded data list select Bit Status
2. Select the Data Type (%I for example). Select Token Pair (“OFF”/”ON” for example).
3. Enter a number for the Location  (register or other, 10 for example).
4. If a word Data Type is chosen, enter a Bit Number in the range of 0-15 under Format.  If bit 0 is off,

then “OFF” is displayed.  If bit 0 is on, then “ON” is displayed.
5. To modify a token pair, select the token pair to be modified.
6. Click Edit Tokens.
7. Enter the “ON” and “OFF” descriptions (up to 10 characters) in the Enter Bit On Token and Enter Bit

Off Token boxes.
8. After being modified, the modified token pair can now be selected as normal.
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4.5.2 To select the data field for editing:
1. From the appropriate page, press the Pause key. The selected field becomes highlighted.
2. To turn the bit off or on, press the Down key or the Up key and press “Enter” to send the data to the

PLC.

Figure 4.5 – Configure Bit Status
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4.6 System Variables
4.6.1 Scope
This section describes the system variables available in the TIU050/10X/11X/20X.  Use the instructions
as follows to embed system variables.

There are six different types of system variables.  To embed system variables:
1. From the embedded data list select System Variable.
2. Select a system variable type under Select System Variable in the Format section.
3. Click OK.

4.7 Passwords
4.7.1 Scope
This section describes the Password function available in the TIU050/10X/11X/20X.  Use the instructions
as follows to embed Password.

4.7.2 To password protect a sub-menu:
1. From the embedded data list select Password. A series of question marks appear on the screen.

Click OK
2. Select Create SubMenu from the Edit menu. Enter the number of pages, you then have the option of

password protecting the submenu.
3. There are two types of security access on sub-menus.

• Simply one password to enter the sub-menu
• Authority Level Mode

Figure 4.6 – Configure System Variable

Figure 4.7 – Configure Password
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The Authority Level Mode allows the programmer to give security levels to each sub-menu. Click
Authority Level Mode and then enter the Authority Level to that sub-menu. Each Level can be given an
individual password.

4.7.3 To enter the password from the TIU050/10X/11X/20X:
1. In the appropriate page, press the Pause key. The selected field becomes highlighted.
2. Enter the password by incrementing or decrementing the data field, by pressing the Up or Down key

respectively.
3. Press the Enter and Up keys simultaneously.
4. The data must be equal to the pass code in order to enter into the sub-menu.

Figure 4.8 – Configure Password Authority Mode
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4.8 Analog Meters
4.8.1 Scope
This section describes the Analog Meters function available in the TIU050/10X/11X/20X.  Use the
instructions as follows to embed Analog Meters.

An area of the display can be horizontally filled to create an analogue meter or gauge.  The height of the
block is fixed at the height of the current text line.  To create a horizontal fill:

1. From the embedded data list select Analog Meters. Select the Data Type and Location under Data
Source.

2. Type the Number of Characters under Format.  The maximum width of the block is determined by
the width of the page and the character size.

3. Select the Maximum and Minimum range.  Minimum and maximum values define empty and full
scale, respectively.

Note: Only 16-bit registers may be read from the PLC.  Only linear scaling is supported.

Figure 4.9 – Configure Analog Meters
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4.9 Text Selector
4.9.1 Scope
This section describes the Text Selector function available in the TIU050/10X/11X/20X.  Use the
instructions as follows to embed Text Selector.

Text Tables are available in the TIU050/10X/11X/20X CBREEZE software. There are 250 available text
tables for use and they may be numbered from 1 to 250. Each text table may have up to 256 entries
(numbered 0 to 255). Entries within each table may be called up by using the selected PLC register.
When the ID of the entry is called up in the PLC register, the text string (entry) is displayed. The text
strings are automatically forced to the width of the longest text string in the table (selected table). Strings
are automatically left justified. Text tables are typically used in situations where the operator desires a
visual message when some event (such as a value change in a register) occurs.

Example: A PLC is controlling a process that manufactures one of four drink types: Cola, Lemonade,
Orange Juice, and Apple Juice.

The PLC has a register that contains the value of “6” when Cola is being made, “8” when lemonade is
being made, “12” when Orange Juice is being made and “24” when Apple Juice is being made.  A Text
table can be created with four entries, 6, 8, 12 and 24, with the text for these items being the four
products.  Now, the PLC register can be monitored and the appropriate text inserted into a page on the
TIU050/100/110.

A maximum of 64kBytes can be used by all of the text tables.

4.9.2 Edit Text Tables
Text tables can be edited from the TIU050/100/110.  To choose the Text Selector function:

1. Select Text Selector embedded data list.
2. Select a Data Type and choose a number for the Location. The value in the Location (register or

other) determines the text string (entry) number displayed (see 6.11).

Figure 4.10 – Configure Embedded Data
Box
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3. Select a text Table ID number (1-250).
4. If you want the ability to edit the text string from the TIU050/10X/11X/20X, click the Edit Enable box.
5. To create/edit/delete entries, click the Edit Table button.
6. A Text Table box appears and the user has the ability to Add, Delete, and Edit text strings.

4.9.3 To Add a Table Entry
1. Click Add Figure 4.11 is displayed.
2. The field ID is automatically the next the available number in the table. This can be changed by typing

in the number required or incremented using the up and down buttons to the right of the field.
3. In the text field enter the text corresponding to that field ID.
4. The size of the font which the text will be displayed can then be set to the character set sizes 6 x 8 or

12 x 16.
5. The programmer can enter the customised character generator by clicking edit font, see Chapter on

Character Generator for further details.

Text tables can be called in 3 different modes, Decimal, Binary and Hexadecimal. This refers to the
format of the data in the register calling the text table. Also in Binary mode multiple text table entries can
be displayed the user can then scroll between these text table entries, or set the Auto Scroll option to let
the TIU to automatically scroll between all the selected entries.

Figure 4.12 – Edit Text Table Entries

Figure 4.11 – Text Table Field Entry
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4.9.4 To edit a text table from the TIU050/10X/11X/20X
1. Select the text string field by pressing the Pause key.
2. Move up or down the list using the Up and Down keys.
3. Press the Enter key to select the desired text string.

4.9.5 To Export/Import a Text Table
a.  Export
1. Click the Export button.
2. Enter the location of the file.
3. Enter the name the file the text table is to be exported to.

b.  Import
1. Click the Import button.
2. Click on the file to be imported.

4.9.6 Auto Mask Bit
The Auto Mask function allows the programmer is a function, which allows the programmer to mask off a
specified number of bits in a register.  When the Auto Mask Bit is selected an extra field appears in the
Configure Text Selector Embedded Data window called Bit Offset. This field contains the number of bits
to be masked off beginning with the first bit of the register.

4.9.7 Default Text Table Entries
If an undefined value is entered into the text table entry field (i.e., a value that has not been assigned in
any text table), then one of two different things happen.

a. If the user has assigned a value to the Default Entry in the Text Table box, then that entry number is
displayed. This value is assigned by first checking the box next to Default Entry, then entering a
number in the box below.

Figure 4.11 – Bit Off Set field
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b. If the box is unchecked and a default entry has not been selected, then a series of asterisks
(corresponding to the longest entry in the text table) are displayed.

Example: There are four entries in the text table.  These four entries have numbers of 23, 24, 54 and 67.
The text in these entries is as follows:

23 - Cola
24 - Soda Water
54 - Apple Juice
67 - Orange Juice
100 Undefined

If an undefined value is entered (e.g. 97) then “************” is shown.  If a default entry has been selected,
i.e., 100 (any number can be used), then the text corresponding to 100, “Undefined” is displayed.

4.10 Clock Calendar
4.10.1 Scope
This section describes the Clock Calendar function available in the TIU050/10X/11X/20X.  Use the
instructions as follows to embed Clock Calendar.

If the TIU050/100/110 has been fitted with the real-time clock feature, then the time and/or date can be
embedded as data.  To embed the time and/or date:

1. Select Clock Calendar under embedded data list.

Figure 4.12 – Text Table 1
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2. Choose the Format of the time and/or date to be displayed on the TIU050/10X/11X/20X. Click OK.

4.10.2 Clock Calendar Mapping
It is also possible to map the clock calendar (time and date) information to the automation equipment.  To
do this:
1. From Configure, chose Clock Calendar Mapping.
2. Click Enable.  Select the Data Type (register or other) and first register (or other) for the Map Start.

Click OK.
3. The mapping is displayed in the Map field (see Figure 4.14).

Figure 4.13 – Configure Clock Calendar Data

Figure 4.14 – Clock Calendar Mapping
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4.11 Menu Timeout
4.11.1 Scope
This section describes the Menu Timeout function available in the TIU050/10X/11X/20X.  Use the
instructions as follows to embed Menu Timeout.

The Menu Timeout is a useful safety feature.  This forces the TIU050/10X/11X/20X back to the first (main)
menu page after a set time period.  For example, the TIU050/10X/11X/20X is on an input menu page,
after 30 seconds of no activity, the TIU050/10X/11X/20X reverts back to the non-input (safety) main menu
page.  To set the timeout:

From the configuration menu, select Configure, then Menu Timeout.  A timeout is set in ALL menu and
sub-menu pages. Time-outs in each screen may be inhibited from the Edit menu. To disable the Timeout
function, set the time to 0 seconds.

Figure 4.15 – Set Menu Timeout Box
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4.12 Flashing Characters
4.12.1 Scope
This section describes the Flashing Characters function available in the TIU050/10X/11X/20X.  Use the
instructions as follows to embed Flashing Characters.

The user may have flashing characters on any line and on any type of page in the project. There are two
different ways that flashing characters are implemented.
a. In the embedded data screen, under Attributes check the box for Flashing.
b. The other way to create flashing characters is to use the “TAB” key when you are creating the project.

Flashing is toggled by line using the “TAB” key (current line the cursor is on). In this case, the entire
line flashes.

Note: Flashing can not be enabled or disabled conditionally.

4.13 Set the Real-time Clock
4.13.1 Scope
This section describes the Set the Real-time Clock function available in the TIU050/10X/11X/20X.  Use
the instructions as follows to embed Set the Real-time Clock.

The Real-time Clock is not a standard feature on all TIUs. The Real-time Clock is set from the PC’s clock.
To automatically set the Real-time Clock from the PC’s clock:
Connect the TIU to the PC.
From File, choose Set Clock.  The PC's time is downloaded to the Unit

4.14 Scaling
4.14.1 Scope
This section describes the Scaling function available in the TIU050/10X/11X/20X.  Use the instructions as
follows to embed Scaling.

Embedded Fields can be Scaled to convert register values from the AE into real-world numbers.

4.14.2 To enable Scaling:
1. From the Embedded Data screen, click Enable in the Scaling box.
2. Enter the TIU Minimum, TIU Maximum, Remote Minimum and Remote Maximum.
3. After configuring any other fields, click OK.

The TIU Minimum and Maximum refer to the minimum and maximum values to be displayed on the TIU.
The Remote Minimum and Maximum refer to the minimum and maximum values produced by the AE.

Example.  Scaling can be used to convert the drive speed in RPM to a conveyor's speed in m/min. This
scaling could then be taking the gearbox and all the other mechanical factors into account.  The
maximum sped of the drive may be 1450, but the actual maximum speed of the conveyor is 100 m/min.
Therefore, the Scaling configuration is as follows:
TIU Minimum 0 (m/min)
TIU Maximum 100 (m/min)
Remote Minimum 0 (RPM)
Remote Maximum 1450 (RPM)
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4.15 Page Wizard
4.15.1 Scope
This section describes the Page Wizard function available in the TIU050/10X/11X/20X.  Use the
instructions as follows to embed Page Wizard.

The Page Wizard is a short cut for building pages to set or view the internal real-time clock or view
communication statistics.

4.15.2 To use the Page Wizard:

1. Move to or insert a page that is to be built.
2. Click the Page Wizard icon or from Configure, choose Page Wizard.
3. Click on the Page Type to be built and chose the particular Parameters to be displayed on the TIU.

Click Build Page.

4.16 Graphing (Not available with the TIU050)
4.16.1 Scope
This section describes the Graphing function available in the TIU050/10X/11X/20X.  Use the instructions
as follows to embed Graphing.

This features graphs up to two plots of 21 contiguous registers.  Plot 1 is the lower byte of the register
and plot 2 is the upper byte of the register.  The graph is updated continuously.  The actual update time
depends on the equipment connected to the TIU, and communication speed.  The data structure is as
follows:

Figure 4.16 – Page Wizard
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Offset +0 Offset +1 Offset +2 .   .   . Offset +21
Points Data 1 Data 2 .   .   . Data 21

Points HIGH Byte = Number of point for plot 2
LOW Byte = Number of points for plot 1
Definitions: 0 = do not plot;

1 = plot first 11 registers on X-axis using 10 pixels per register;
2 = plot 21 registers on X-axis using 5 pixels per register;
>2 = assume 2.

Data HIGH Byte = Data for plot 2, ploted with a dotted line
LOW Byte = Data for plot 1, plotted with a solid line
The scale of the Y-axis is 0 to 29.  Values greater than 29 or negative values are plotted full
scale.

4.16.2 To Embed a Graph:

1. Select Embedded Data from the Edit menu
2. Select Graph under Type.
3. Select a Data Type (register or other) and a Location (this is the First Data register).
4. Enter the number of points on the Graph, the number of points equals the number of data registers

required.

Figure 4.17 Embedding A Graph
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5. Click OK.

4.16.3 Enable Axes
When this option is selected the X and Y-axes of the Graph is displayed on the TIU11X/TIU20X when the
project is downloaded.

Note: The graph uses up 3/4 of a menu or submenu page and as such overwrites whatever data is on
that page.

4.17 Trending (Not available with the TIU050)
4.17.1 Scope
This section describes the Trending function available in the TIU050/10X/11X/20X.  Use the instructions
as follows to embed Trending.

This features continuously plots up to two registers (channels) versus time. The maximum update rate
depends on the equipment connected to the TIU, and communication speed.

4.17.2 Enable Axes
When this option is selected the X and Y-axes of the Trend are when the project is downloaded.

Figure 4.18 Embedding A Trend
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4.17.3 Data Indirectly Specified.
This option allows the programmer to indirectly specify the register which contains the data for the trend,
i.e. the contents of the register, which is specified in the Location section of the Remote Data Source,
specifies the register that contains the data for the trend.

4.17.4 Control Data from Remote Device
This option allows the programmer to control the set-up of the trend from registers stored in the
automation equipment. The structure for setting up the trend is described further in this paragraph.

The data structure is as follows:

Offset +0 Offset +1 Offset +2 Offset +3 Offset +4 Offset +5
Time Base Ch. 1 Scale Ch. 1 Data Ch. 2 Scale Ch. 2 Data Width

Time Base 0 = maximum update rate;
1 = 1/10s per plot
X = X/10s per plot, up to X=10

Scale Maximum value of Y-axis for that channel; if 0 channel is not plotted.

Data Raw register values.  Negative values are plotted at full scale.

Width Number of samples across the display
100 = 1 pixel per plot
50 = 2 pixels per plot
25 = 4 pixels per plot
10 = 10 pixels per plot
Any other value, the nearest to the above 4 is used.

If the Control Data from Remote Device option is not clicked then the trend is set-up as follows.

The Time Base is set by the Trend Width.
The scale is set by the Minimum and Maximum Range
The data for the first trace is taken from the register specified or indirectly specified in the Location field
The data for the second trace is taken from the following register specified or indirectly specified in the
Location field.

Note: When Control Data from Remote Device is selected, the data to set-up the structure of the trend is
only read once, when you first go onto a screen where the trend is embedded.  The data for the trend is
read continuously.

4.17.5 To Embed a Trend
1. Select Embedded Data from the Edit menu
2. Select Trend under Type.
3. Select a Data Type (register or other) and a Location.
4. To display axes with the graph, click the Enable Axes under Format.
5. Click OK.

Note: The trend uses up 3/4 of a menu or submenu page and as such overwrites whatever data is on that
page.
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CHAPTER 5: CHARACTER GENERATOR

5.1 Scope (Not available on the TIU050)
The CBREEZE software allows the user to edit, create and display on the TIU10X/11X/20X special
characters.  These characters may be company logos, special symbols or multilingual, non-standard
KEYBOARD characters such as Ω , é, °, © or ±.

Note: The character set for the font double height is scaled automatically from the 8x6-character set.  The
character set for the font x4 is scaled automatically from the 16x12-character set.

Within each character set are up to 256 characters, however, not all these characters are usable and/or
editable by the user.

Table 5.1 – Make-up of a Character Set
Characters 0 to 31 System characters – not useable or editable
Characters 32 to 127 Standard keyboard characters – useable and editable although it

is not recommended the user edit these characters.
Characters 128 to 160 Editable and useable characters.  This is the area of the

character set for use.
Characters 161 to 255 Extended keyboard characters – useable and editable although it

is not recommended the user edit these characters.

5.2 To Insert a Special Character:
1. Place the pointer on the display where the character is to go.
2. Press <Ctrl> <Enter> or by clicking right mouse button.  Click on the character in the Character

Map (see Figure 5.2) to be inserted.



PAGE 48                                                         06 Apr 2000                              CH. 5: CHARACTER GEN.
GFK-1818

5.3 To Create Or Edit a Character:
1. From Configure on the menu bar, choose Fonts.  The screen in Figure 5.1 appears.

2. Under Character Set, choose the Character Size to be edited.  Beside Set Name, enter a name
that describes this set.

3. Click on Map to show the total character set. The screen in Figure 5.2 appears.  The first four
rows are the standard keyboard characters, which should not be edited.  The fifth row is editable
and useable. The lower three rows are the extended keyboard characters, which should not be
edited.  Click on the character to be edited or blank box to create a character.

NOTE: Standard and Extended keyboard character are editable; however, this must be done with caution
as it effects how characters are displayed on the TIU050/100/110, i.e., changing “4” to • causes all 4’s
from the PLC to be displayed as •.  454 is displayed as •5•.

4. Under the Character Bitmap (see Figure 5.1), click on a square (pixel) to toggle that square on
or off.  The grey area is the space between characters and these squares should not be turned on.
5. Go to step 3 to edit the next character.

Figure 5.1 - Character Generator Screen

Figure 5.2 – Character Map

Character Size

Character Number

Name of Set

Edit Standard
keyboard Characters

Saves Character File

Loads Character File

Doubles the size of
the 8x6 set only

Click on a square to toggle that square on or
off or drag and draw white of black lines. Shows spacing

Edit this row
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6. Once all the characters have been created or edited, click Save File.  Choosing Yes over-writes
the current character file.  Choosing No gives the option to save this character set under a new
file name.

Note: It is possible to double the size of an 8x6-character set.  To do this click on the Double button.  It is
not possible to half the size of a 12x16-character set.  It is recommended that the 8x6-character set be
created first and then doubled.

5.4 International Keyboards
The CBREEZE software supports various international keyboard layouts.  However, if the standard or
extended keyboard characters are edited or deleted, the pressed key may appear different or not at all.
The following keyboard layouts are supported:

Table 5.2 – Supported Keyboard Layouts
Danish German (Standard)
Dutch (Belgium) Italian (Standard)
Dutch (Standard) Norwegian
English (All) Spanish (Modern Sort)
Finnish Swedish
French (Standard)
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CHAPTER 6: RECIPES

6.1 Scope
Recipes allow the user to send or update multiple registers simultaneously.  For example, it may be
desired to run a motor at two different settings for two different applications.

a. Speed of 1000RPM, minimum frequency of 500Hz, acceleration rate of 1000 s/100Hz and
deceleration rate of 2000 s/100Hz;

b. Speed of 500RPM minimum frequency of 400Hz, acceleration rate of 500-s/100Hz and
deceleration rate of 1500 s/100Hz.

Recipes enable the user to download all the fields (four in this example) at the same time without editing
each individual field.

A maximum of 63 fields and 1024 records are supported by the database. The total storage available to
the database is 64 kBytes. The number of bytes currently in use can be obtained from the main
CBREEZE help menu under About CBREEZE.

6.2 To Enable Recipes:
1. From Configure, select Recipes.  Enter the Recipe Name, Number of Records in the Database

and Number of Fields in Record.  The number of Records and Fields can be changed later.  Click
OK.

2. The TIU Recipe Database Editor appears.  Set the number of Records (different settings) and Fields
(parameters).

3. Edit the Fields and Records as desired.
4. From File, select Exit to leave the Recipe Editor.

6.3 To Edit Recipe Fields and Records:

1. Open the Recipe Editor by clicking on the Recipe icon  on the Toolbar or from
Configure/Recipes.

2. Left click on the Field to be edited.  Enter the Ingredient Name, Type Remote Data Source
(register) and Format in the same manner as Embedded Data. Enable Scaling if desired.

3. Left click on the Record to be edited.  Enter the value and click OK or press <Enter>.
4. From File, select Exit to leave the Recipe Editor.

Fig 6.1 Database Editor Window
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6.4 Editing Ingredient Properties
An ingredient, or field, in the database corresponds to a value which will be loaded to a specified location
either internal to the TIU or in the connected automation equipment.

Each field has the following properties: -
a) Ingredient name
An alphanumeric string that is used to specify which field in a recipe is being edited. The string may be up
to 30 characters in length.

b) Type
Currently recipe data fields may be formatted as numeric, timer, alphanumeric or bit.

c) Remote data source
The register to which the recipe field data will be transferred when the recipe is selected for loading.
Where the type is specified as alphanumeric it refers to the first register of a contiguous block where the
number of characters in the alphanumeric string defines the block size. (block length = (2 x (characters +
Refer to the alphanumeric embedded data section for more details on how an alphanumeric string is
stored.

d) Format
Additional data to specify the format of the data field dependant on its type.

Figure 6.2: - Ingredient Properties
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e) Range checking
Optionally set limits on numeric and timer data, which are applied when the operator modifies the data
from the keypad.

f) Scaling
Where the data is formatted as numeric or timer data, and the data is mapped to the automation
equipment, scaling allows an offset and multiple data transformation to occur prior to sending.

6.5 To Edit Recipe Data
Double click on the field to be edited. If the data is a bit status it will toggle, otherwise the following prompt
will appear: -

Enter the data required for the field

6.6 To Rename a Record
1. Double click on the record name

2. Type in the new record name
3. Click OK.

Figure 6.4 – Record Name

Figure 6.3: - Edit Data
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6.7 To Embed a Recipe on a Menu Page
When embedding a recipe item on a menu page the following box is displayed.

The three format types are; -

a) Recipe Selector
The Recipe Selector field allows the user to select a recipe from the database.
The recipe selector requires a field to be selected from the database, typically this will simply be the
record name.
The recipe selector initially displays the contents of the specified field within the first record in the
database. The operator will be able to scroll through the records in the database to select the record on
which he wants to operate. When the required record is found, the Enter key is pressed and the desired
record is selected.
The recipe selector is used either on it’s own, in which case the page is a recipe selection page and upon
selecting the record the contents of that record are transferred to the TIU internal registers and/or the
automation equipment. Otherwise the recipe selector is used in conjunction with a recipe field tag and a
recipe field contents embedded data field, in which case the page is a recipe editing page used to modify
the values loaded by the specified record when selected.

• Recipe Name will allow the user to edit the contents of each Item of the displayed Record; the
Record name will be displayed.

• If one of the Items is selected then the user can edit the contents of each Item of the displayed
Record; the Record number will be displayed.

b) Recipe Field Tag
If the Recipe Field Tag is embedded on the menu page then the Item Name of the record selected for that
menu page will be displayed. The recipe field embedded data must always be used in conjunction with
both a recipe selector and recipe field contents embedded field. If all three recipe embedded data types
are on screen the page is used for editing a recipe. Initially when a page is displayed the recipe field tag
will be blank. It remains blank until a recipe has been selected using a recipe selector field. At this point
the first recipe field is selected for editing and the name of this field is displayed as the recipe field tag. As
the operator enters each recipe item, the recipe field tag moves on to the next field tag until all fields in
the recipe have been modified or accepted.

Figure 6.5 - Embed Recipe Item
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c) Recipe Field Contents
If the Recipe Field Contents is embedded on the menu page then the contents of the current Item, of the
record selected for that menu page, will be displayed. The recipe field contents embedded data must
always be used in conjunction with both a recipe selector and recipe field tag embedded field. If all three
recipe embedded data types are on screen the page is used for editing a recipe. Initially when a page is
displayed the recipe field tag will be blank. It remains blank until a recipe has been selected using a
recipe selector field. At this point the first recipe field is selected for editing and the name of this field is
displayed as the recipe field contents. Once all the fields in the record have been accepted the modified
record is written to flash memory in the terminal. Note that to send the contents of the newly modified
record to the automation equipment and/or the TIU internal registers the operator must call up a recipe
selection page and select it in the normal manner.
Pressing the pause key at any point during the editing sequence will abort data editing, and cause any
changes to the recipe data already made to be ignored. The flash memory is only updated if all fields are
accepted with the Enter Key.
Because of the precise nature of the combinations in which the recipe embedded fields must be used in
order to achieve a specified function it is recommended that the page wizard is always used to build
recipe operation pages!

Note: A recipe item can be manually embedded on a menu page however for best results when
embedding a recipe item on a screen see the Page Menu Wizard for Recipe Items. This can always be
edited afterwards.

6.8 Importing and Exporting Data from a Recipe
Recipe tables can be imported or exported.  Files can be imported or exported as coma delimited (*.csv)
or as print files (*.prn).  Other file types may be viewed but may not load properly.

Note: Only Records are exported and imported, the Field names are not.

Note: If the table size that the data has been imported into is smaller then the table it was imported from,
then not all of the data is displayed.

Note: Only one Record column can be selected per project at any time.



PAGE 56                                                         06 Apr 2000                                              CH. 6: RECIPES
GFK-1818

NOTES



CH. 7: TUTORIAL                                           06 Apr 2000                                                         PAGE 57
GFK-1818

CHAPTER 7: TUTORIAL

7.1 Scope
This chapter contains instructions for using several of the OS features.  The projects in this chapter serve
as examples and are not to be taken literally for all applications.  After following this tutorial, the user
should have a better understanding of how the OS operates.

7.2 Menus
The OS supports a total of 300 pages divided between menu and sub-menu, alarm and status pages.
The following points are covered in this section:

1. Menus can have sub-menus.
2. Sub-menus can have sub-menus.
3. There may be up to 8 embedded data per page.
4. Embedded data can be displayed-type or entry/editing-type.
5. Sub-menus can be password protected.

Additional menu pages may be created by selecting Insert Page from the Edit menu or by selecting the
“+” icon from the icon menu to the right of the Display screen.  Selecting Delete Page from the Edit menu
or by selecting the “-“ icon will delete the displayed page.

The next menu page may be selected by clicking the “Down” key or by selecting the Next Page from the
Goto menu.  The previous menu page may be selected by clicking the “Up” key or by selecting Previous
Page from the Goto menu.

Example:  The OS is used to monitor the temperature of a furnace and indicate the heater or a fan is ON
or OFF.  This example uses a Hitachi H-252 series PLC, but is applicable to any PLC with modifications.
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1. Communication Settings from Configure.  Select the applicable automation equipment being
used, in this example a Hitachi H-series is used.  Click OK.  Update the Protocol if required

2. Menu Page 1 shows some explanatory details about the program and should look like figure 7.1.
For “Furnace Control #1” on line 3, click on the font double height icon at the beginning of the
line.

3. Click on the Insert Page Icon.  Choose Insert After Current Page.  Click OK.

Figure 7.1 – Menu Page 1



CH. 7: TUTORIAL                                           06 Apr 2000                                                         PAGE 59
GFK-1818

Figure 7.2 – Menu Page 2

Figure 7.3 – Menu Page 2
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1. Enter the text as shown in Figure 7.2.
2. Place the cursor one space to the right of “Temperature” and embed a Numeric Data in WR-

REGISTERS Location 10.  Select “XXX”, 16-Bit, Unsigned.  Click OK.  Correct “C” position.
3. On the first space of the fourth line, click the embed icon.  Choose Analog Meter, WR-

REGISTERS and Location 3.  Under Format, enter 15 for characters, 760 for Maximum and 0
for Minimum.  Click OK.

4. Place the cursor 6 space to the right of “Heater” and embed a Bit Status in Y-REGISTERS,
Location 100, Select Token Pair Format, “OFF”/”ON.”  Click OK.

5. Place the cursor 9 spaces to the right of “Fan” and embed a Bit Status in WR-REGISTERS,
Register 10, Select Token Pair Format, “OFF”/”ONFF”, Bit Number 1. Click OK.

6. After embedding the data, the screen looks like Figure 7.3.

Under the File menu, click Download Project.

The temperature is displayed digitally and as a bar graph by the horizontal fill.  Also, it is shown whether
the heater and fan are ON or OFF.

Note: For this example to work a thermocouple and relay module must be used to simulate temperature,
heater and fan.  Otherwise the latent values displayed will be blank or the values in the PLC registers.

7.3 Sub-Menus
Sub-menu pages branch off menu pages analogous to a sub-directory branching off a main directory of a
PC.  The OS supports a total of 300 pages divided between menu and sub-menu, alarm and status
pages.

Example:  Continuing from the example in Figure 7.2, one sub-menu is set up for the heater and one for
the fan.  Each sub-menu sets the temperature (within the furnace) at which the heater or fan turns
ON/OFF.

Note: Ladder code needs to be written if this example is to work as anything more than an example.

1. Go to menu page 2.  Under the Create SubMenu page, choose 2 for the Number of Pages.  Be
sure that the Password Protect box is unchecked.  Click OK.  The bottom middle cell should
display Menu Page 2.1 (indicating a sub-menu).
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2. After completing this, enter the text as shown on the first sub-menu page (as follows):

3. Embed data one space to the right of “ON Temperature” by selecting Numeric for the Type, WR-
REGISTERS for the Data Type and Location 10.  Under Format, select “XXX”, 16-Bit
Unsigned and click on Edit Enable.  Click OK.

4. Do the same as in step 3 for “OFF Temperature” but use Location 11.
5. On the sixth line, one space to the right of “Manual Override” embed a Bit Status in WR-

REGISTERS, Register 10, Select Token Pair Format, “OFF”/”ON”, Bit Number 1, Click on Edit
Enable. Click OK.

Figure 7.4 – Sub-Menu Page 2.1
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6. Highlight the display screen, and select Copy from the Edit menu.  Select Next Page from the
Goto menu.  Select Paste from the Edit Menu.  Change the “Heater” to “Fan” and Fan ON and
OFF temperature registers to 20 and 21, respectively.  Change the Bit Number to 1 for the
embedded data beside Manual Override.

7. Return to the parent menu by selecting Parent Menu from the Goto menu.

Under the File menu, you can Save Project, then Download Project.
The Screen appears as in Figure 7.5.

7.3.1 To Enter A Sub-Menu On the OS:
1. To go into a sub-menu from the main menu, press the Pause key and the Down key at the same

time.
2. To edit the data, press the Pause key.  Press the Down key to decrement the data, the Up key to

increment the data and the Enter key to enter the data.
3. Press the Pause key and the Up key to return to the parent menu or the Down key to go to the

next sub-menu page.

Figure 7.5 - Sub-Menu Page 2.1
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7.4 Password-Protected Sub-Menus
7.4.1 Scope
This tutorial section of the manual covers how to create password-protected sub-menus.

Example: Continuing from the example in 7.2, one sub-menu is set up for the heater and another for the
fan.  Each sub-menu sets the temperature (within the furnace) at which the heater or fan turns ON/OFF.
This is the same as the example in 7.3 except that the sub-menus are now password protected.

1. Create a new menu page by selecting Insert Page from the Edit menu.
2. Enter the text, as shown in Figure 7.6.

3. Place the cursor one space to the right of “CODE” and select Embedded Data from the Edit
menu.  Select Password for the Type.  Click OK.  Four question marks should appear beside the
word “CODE”.

4. Go to menu page 3.  Select the Modify SubMenu Properties, and choose 2 for the Number of
Pages Check the Password Protect box, and enter a Password of “1234”.  Click OK.  The
bottom middle cell should display Menu Page 3.1 (indicating a sub-menu).

5. Follow steps 2 through 8 in 9.3.
6. Save and Download Project to the OS.

Figure 7.6 - Password Enter Screen
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The resulting display screen on the OS appears as the screen shown in Figure 7.7 (with a code of 0000).

7.4.2 To Enter the Sub-Menu:
1. Press the Pause key to edit the Pass Code.
2. Press the Up key to increment the code, 1234 in this example (hold the key down for speed

incrementing), the Down key to decrement the data and the Enter key to enter the data.
3. Press the Pause key and the Down key at the same time to select the sub-menu page.  The sub-

menu page is only selected if the Pass Code is correct.

7.4.3 To Edit The data On The Sub-Menu Pages:
1. Press the Pause key to select the field to edit.
2. Press the Up key to toggle or increment the field.  Press the Down key to toddle or decrement

the field.  Press the Enter key to send the value to the PLC.
3. Press the Pause key to select the next field to edit.
4. Press the Pause key and the Up key at the same time to return to the parent menu.

Figure 7.7 - Password Enter Screen
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7.5 Status
7.5.1 Scope
The OS can display STATUS information.  For example, a status page can be displayed as COILS
change (in real-time) in your PLC, i.e., the first Coil displays the first Status page, the second coil the
second page and so on.

Status messages can have up to eight embedded data values per page.  Up to 300 total pages are
available split between Status, Alarms and Menu pages.

Two different modes are available for configuring status pages.  These modes are the Bit Mode and the
Direct Mode.

• Direct Mode reads only one register as a word from the PLC for the status page.  If the value in
this register is zero or greater than the number of configured status pages in the system, the
main menu screen is displayed.  Otherwise, the appropriate status screen is called up.

• Bit Mode works essentially the same, except that the screens are controlled by discrete bits
instead of the full word register values.

NOTE: Status pages are only displayed when MENU PAGE 1 is selected.

Example:  The following example involves the OS connected to a GE Fanuc 90-30 PLC.  It is applicable
to any of the supported automation equipment (see 7.3) with substitutions made for the specific
registering nomenclature, i.e., %Q is a discrete bit output.  It is assumed the PLC is properly configured,
the OS is properly connected to the PLC, both are powered up, and the CBREEZE software, TSW232, is
running on the PC.

1. Select Communication Settings from the Configure menu.  Select the automation equipment
type you are using.  For the example here, a “GE Series 90 SNP protocol” is being used. Click
OK.

2. Insert a menu page after Menu Page 1 (refer to 7.2 for instructions).  Place the cursor at the left
on the first line.  Click the double height icon.  Type “Discrete Outputs:”

3. On the third line, type “Q1:”.  Click on the Embed Icon.  Select Bit Status from Type; discrete
output (in this example %Q) from Data Type; Location 1; leave Token Pair as “OFF”/”ON” and
click Edit Enable. Click OK.  See Figure 7.8.

4. Do the same for Q2, Q3 and Q4 on lines 4, 5 and 6, incrementing the Bit Number by one.  These
discrete outputs will simulate coils.  Menu Page 2(2) should be the same as Figure 7.9.



PAGE 66                                                         06 Apr 2000                                           CH. 7: TUTORIAL
GFK-1818

Figure 7.9 – Menu Page 2(2)

Figure 7.8 – Configure Embedded Data Box
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From Configure, choose Status.  Click Direct Mode.  From Data Type choose discrete output (%Q in
this example); Block Start equals1.  The Number of Status Pages equals 4. Click OK.

From View, choose Status.  This displays the first of four status pages.  On the third line, delete what is
there and type “Status Page:” on the fourth line, click on the x4 icon and type “1” in the centre of the line.
Status Page 1 appears as the screen in Figure 7.11.  Highlight display screen,
click Edit and Copy.

Figure 7.10 – Configure Status Pages

Figure 7.11 – Configure Status Pages



PAGE 68                                                         06 Apr 2000                                           CH. 7: TUTORIAL
GFK-1818

Click the down arrow icon on the project software to get to Status Page 2 of 4.  Delete what is on the
display screen, then from Edit, choose Paste Page.  Change the “1” on line four to a “2.”  Do the same
for pages 3 and 4.

From File, choose Download Project

On the OS, press the DOWN key to get to the Discrete Output page (as in Figure 7.8).  Press the PAUSE
key the toggle Q0: ON by pressing the UP key and ENTER key.  Press the PAUSE key until nothing is
highlighted (three times).

Press the UP key.  The page shown in Figure 7.12 should be displayed.

Note: Status pages are only displayed from Menu Page 1.

5. Press the DOWN key and return to the Discrete Outputs page.  Toggle Q1:OFF and Q3:ON.
Return to Menu Page 1 by pressing the UP key.  Now Status Page 4 is displayed.  This is
because Direct Mode is selected and the register is being read as a word, i.e., 0100 binary = 4.

6. Toggle Q1: ON, Q2: ON, Q3: OFF and Q4: OFF.  Now Status screen 3 is displayed (0110B=3).
7. Toggle Q4: ON and all the other OFF.  Now a screen with “Default Menu Screen” written on the

second line is displayed.  The OS is looking for Status Page 8 (1000B = 8), which does not exist,
so the default screen is displayed.

8. In the CBREEZE software, choose Status from Configure.  Click on Bit Mode.  Click OK.
Download the project to the OS.

9. Now Status Page 4 is displayed.  In Bit Mode, the OS reads the register as discrete bits, not as a
word, i.e., 1000 triggers Status Page 4, 0100 triggers Status Page 3, etc.

Figure 7.12 – Status Page 0
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7.6 Alarms
7.6.1 Scope
The OS can display ALARM information as BITS change in your PLC (real-time).  The active alarms can
be accepted and then SCROLLED through. Up to 300 total pages are available split between Alarms,
Status and Menu pages.

The OS also has an Alarm Acknowledge Table.  This feature allows a set of bits to be written back to the
PLC to indicate alarms that have been accepted by the user, but are still “ON” in the PLC table.  These
bits are in the same format as the “incoming” alarm bits.  The acknowledgement bits are set when an
alarm has been acknowledged, provided that the corresponding bit is still active in the alarm table.  The
acknowledgement bit is cleared when the corresponding alarm bit is cleared.  Click the Enable box to use
the Alarm Acknowledge Table.

Example:  The TIU100 or 110 is connected to a GE Fanuc 90-30 PLC.  Register %R20, bits 1, 2, 3 and 4
are the alarms.  Register %R21, bits 1, 2, 3 and 4 is the acknowledgement table.  The instructions below
are a tutorial of how to use the Alarms on the OS.

1. Select Alarms from the Configure menu.

2. Set the Data Type to %R.  Enter the location of the Block Start as 20.
3. Enter the number of alarm pages in the Number Of Alarms box (4 for example).  If the number

of alarms is greater than 16, then the next PLC register is read.
4. Check the Acknowledgement Table Enable box.  Set Data Type to %R and Block Start to 21.

Click OK.
5. Insert a page (Page 2) after Page 1.  Go to page 2.  On the second line type “Alarm:” and embed

%R20 beside.  Make the embedded %R20 field Numeric, two digits and Edit Enabled with a
Range Maximum of 15.  This field acts as the alarms.

6. On the fourth line, type “Acknwldg Table:” and embed %R21 beside. Make the embedded %R22
field Numeric and two digits.  This field holds the Acknowledgement table.

7. Select Alarms from the View menu.  The bar at the bottom displays the alarm page selected.

Figure 7.13 – Configure Alarm Box
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The next alarm page can be selected by clicking the Down key or by selecting Next Page from the Goto
menu.  The previous alarm page can be selected by clicking the Up key or by selecting Previous Page
from the Goto menu.

8. Enter text in Figure 7.14.

9. Place the cursor beside either “ACCEPTED” OR “UNACCEPTED” and select Embedded Data
from the Edit menu or click the embedded data icon (X.X).

10. Select System Variable under Type and XXX Accepted Alarms or XXX Unaccepted Alarms
under Select System Variable in the Format section.

11. Block the entire page.  From the Edit menu, select Copy (or type <Ctrl-C>).
12. Page down to Alarm Page 2 of 4 using Next Page from the Goto menu.  Paste Page 1 to Page 2

using Paste from the Edit menu (or <Ctrl-V>).  Do the same for alarm page 3 and 4.

Figure 7.14 - Alarm Page 1 Screen
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13. Download Project to the OS.  Put your PLC in “RUN” mode.

On the OS:

Scenario 1: energise alarm 1.  Go to page 2.  Select the field beside “Alarm” by pressing the Pause key.
Change the value to 1 and press the Enter key.

Action: Alarm Page 1 is displayed.  The user presses Enter. The alarm page goes away and “Acknwldg
Table:” (%R21) equals 1 indicating alarm 1 has been acknowledged.

Scenario 2: energise alarm 3.  One page 2, change the Alarm field to 0, press Enter.  The “Acknwldg
Table:” field returns to 0 as well.  Set the “Alarm” field to 4 (the OS read discrete bits for the alarms, so
0100 binary, i.e., bit 3 high equals 4 decimal).

Action: Alarm Page 3 is displayed.  The user presses Enter. The alarm page goes away and “Acknwldg
Table:” (%R21) equals 4 (i.e., bit 3 is high) indicating alarm 3 has been acknowledged.

Scenario 3: energise alarms 1, 2 and 3.  One page 2, change the Alarm field to 0, press Enter.  The
“Acknwldg Table:” field returns to 0 as well.  Set the “Alarm” field to 7 (the OS read discrete bits for the
alarms, so 0111 binary equals 7 decimal).

Action:
a. Alarm pages 1, 2 and 3 are active.  Alarm page 1 is displayed as the first alarm.  Until any alarms are

accepted, the Alarms Accepted reads 000 and the Alarms Unaccepted reads 003.

b. The next Active alarm page can be selected by pressing the Down key on the OS.  The last Active
alarm can be selected by pressing the Up key on the OS.

c. The Active Unaccepted Alarms can be accepted by pressing the Enter key on the OS. Only one
alarm is accepted at a time.  Once an alarm is accepted, the next alarm is displayed.  Accept all 3
alarms.

Go to page 1. Accepted Active Alarms can be recalled by pressing the Enter key.  Accepted Active
Alarms are scrolled through with the Up key and the Down keys on the OS. Pressing the Enter key
again returns display to page 1.

Note: Active Unaccepted alarms are displayed as a priority on any page.
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NOTES
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CHAPTER 8: GRAPHIC EDITOR

8.1 Scope
The TIU Graphic editor is designed to be a simple Drawing and Graphic Editor to be used with the
TIU20X. The TIU20X can have 2 types of pages, a Text Page and a Graphic Page. The text page works
similarly to the menu pages on the TIU10X/11X. On Graphic pages, as well as all the features of the text
page, also includes many other graphical features, such as; Shapes with 3 different backgrounds, bit
maps and bit map animation.

All features are designed to be intuitive to the experienced user of Windows  type applications. The
following paragraphs describe most of the features available, however hopefully the user will find the
software easy to use with some experimentation.

8.2 Draw Mode
Select a drawing mode by clicking on the appropriate button on the Shapes Toolbar, by choosing
Setting/Draw Mode from the main menu. Before drawing the object choose the Background Fill (this
maybe changed afterwards).

8.2.1 Selector

The selector tool may be used to select objects or groups of objects already created. Select an object by
clicking on any part of the object. Set the properties of an object by double clicking on the object.
To select all objects click Edit/Select All.

8.2.2 Rectangle

1. Select Rectangle Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired rectangle. Click and hold the left mouse button.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The Draw Mode returns to Selector as default
6. To edit the size of the rectangle click on the object, then click on one of the black dots around the

object. Drag this dot around on the screen and the rectangle will change size automatically.

Figure 8.1 – The Shapes Toolbar
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8.2.3 Ellipse

1. Select Ellipse Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired ellipse. Click and hold the left mouse button.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The Draw Mode returns to Selector as default
6. To edit the size of the ellipse click on the object, then click on one of the black dots around the

object. Drag this dot around on the screen and the ellipse will change size automatically.

8.2.4 Rectangle with Round Corners

1. Select Rectangle with Rounded Corners Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired rectangle. Click and hold the left mouse button.
4. The Draw Mode returns to Selector as default
5. To edit the size of the ellipse click on the object, then click on one of the black dots around the

object. Drag this dot around on the screen and the ellipse will change size automatically.

8.2.5 Line

1. Select Line Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired line. Click and hold the left mouse button.
4. Drag the mouse to where the second point is to be located is to be located.
5. The Draw Mode returns to Selector as default
6. To edit the size of the line and shape click on the object, then click on one of the black dots

around the object. Drag this dot around on the screen and the line will change size automatically.

8.2.6 Arc

1. Select Arc Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired arc. Click and hold the left mouse button.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The Draw Mode returns to Selector as default.
6. To edit the size of the arc and shape click on the object, then click on one of the black dots around

the object. Drag this dot around on the screen and the arc will change size automatically.
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8.2.7 Text Mode

1. Select Text Mode.
2. The background on text mode is by default transparent (This can be edited later).
3. Click on the screen, this will become the top left-hand corner of the text box.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The Set Text window opens (Fig 8.2)

6. In the text box type the text to appear on screen.
7. The Alignment and Text Direction can be set, along with Invert Colours and Fill Background
8. The text is displayed in the original text area drawn, in an appropriate size font.
9. The Draw Mode returns to Selector as default
10. To edit the size of the font click on the object, then click on one of the black dots around the

object. Drag this dot around on the screen and the font will change size automatically.

8.2.8 Static Bitmap

1. Select Static Bitmap Mode.
2. Click on the screen, this will become the top left-hand corner of the bitmap area.
3. Drag the mouse to where the bottom right hand corner is to be located. This will also set the size

of the bitmap.

Note:  once created the bitmap size can not be changed directly. To change the bitmap size, the bitmap
image needs to be exported to a file, a new bitmap created the required size and the old bitmap image
imported back from the file of the original bitmap image.

Figure 8.2 – Set Text
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The Static Bitmap Editor opens (Fig 8.3)

The tools available to draw shapes using the bitmap editor are very similar to the picture editor. The
exceptions are as follows: -

a. In Text mode only Transparent and Opaque are available for background fill. The font Size needs to
set before beginning to type text, in Setting/Font.

b. A Flood Fill Tool is available. Click the flood fill tool button and then click in the area to be filled.

c. Zoom option. Click the zoom tool button then click on roughly the area to zoomed. A separate
window appears displaying the zoomed area.

d. Left mouse button acts as draw black on green, Right mouse button acts as draw green on black.

Note: The bitmap can be dynamically resized.

Figure 8.3 – Static Bitmap Editor
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8.2.9 Table Mode

This tool allows you to easily draw the lines for a table and enter a Table Header. Once the table is
created the number of rows and columns can not be edited directly. Boxes or lines may be added
manually afterwards.
1. Select Table Mode.
2. Click on the screen, this will become the top left hand corner of the Table
3. Drag the mouse to where the bottom right hand corner is to be located. This sets the size of the table

only.
4. The Table Creation windows open (Fig 8.4)

5. Set the number of columns and rows you require.
6. Click on Add Table Header and enter Table Header Text if required.
7. The 3D effect adds an extra line on the right side of the table to give the effect of shadow.
8. Click OK to create table.
9. The table will then be drawn in the area specified at the beginning.
10. The Draw Mode returns to Selector as default.

Figure 8.4 – Table Creation
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8.3 Embedding Data on a Graphic Menu Page
8.3.1 Scope
The Embedded Data types are similar to the data types on text menu pages. All data types work the
same as they do on a text page see Chapter on Embedded Data. The main difference is how the data
type is embedded on the screen.

To Embeded Data on the Screen
1. Choose the Embedded Data type you wish to embed.
2. Click on the screen, this will become the top left hand corner of the area the displayed data will take

up.
3. The normal embedded data type window will appear. Set-up the embedded dat type as required (See

Chapter on Embedded Data).
4. Once the embedded data type is created it is displayed in the area defined earlier, in a font size

appropriate to the size of the area.

8.3.2 Analogue Meter

Similar to the horizontal meter now added is a “Needle Meter” type Analogue Meter. It is embedded on
the menu page similar to the Horizontal Meter.
To Embeded an Analogue Meter on the Screen
1. Choose the Analogue Meter Data type.
2. Click on the screen, this will become the top left hand corner of the area the displayed data will take

up.
3. The normal embedded data type window will appear. Set-up the embedded data type as required

(See Chapter on Embedded Data).
4. Once the embedded data type is created it is displayed in the area defined earlier.

Figure 8.5 – Embedded Data
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8.4 Animated Bit Map Selector
8.4.1 Scope
In a graphic page also includes the embedded data type Animated Bitmap Selector. The animated bitmap
consists of a set of images, which are selected dependent on the value in a register. It is the pictorial
equivalent of a text table.

8.4.2 To Embed a Animated Bitmap Selector

1. Choose the Animated Bitmap selector Embedded Data type.
2. Click on the screen, this will become the top left hand corner of the bitmap area.
3. Drag the mouse to where the bottom right hand corner is to be located.
4. The normal Animated Bitmap Selector data type window will appear (Fig 8.6).

Chosse the Data Type and the Location of the control register of the bitmap selector.
5. Click on NEW ANIMATED BITMAP.
6. Click edit table and the size of the bitmap icon is displayed (Fig 8.7). The size of the bitmap icon

can be changed now.

Note: Once created the bitmap size can not be changed directly. To change the bitmap size, the bitmap
image needs to be exported to a file, a new bitmap created the required size and the old bitmap image
imported back from the file of the original bitmap image.

Figure 8.6 – Embedded Animated Bitmap Selector Windows
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7. Click OK to display the bitmap icon table.
8. A blank table will be displayed.
9. Click the Add button to display the Icon Editor (Fig 8.8).
10. Select a Field ID number (1-250).
11. Double click on the icon area in the centre of the screen. The Bitmap Editor opens the icon as a

bitmap to be edited. The Icon is displayed with a checkered design as default. To Clear the
bitmap choose Image/Clear from the main menu.

12. See Static Bitmap Editor for details on how to create graphic images in the bitmap icon.
13. Once the bitmap has been completed close the Bitmap Editor and the bitmap icon will appear in

the Icon Editor.

Figure 8.7 – Set Bitmap Icon Size

Figure 8.8 – Icon Editor
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Bitmap tables can be called in 3 different modes, Decimal, Binary and Hexadecimal. This refers to the
format of the data in the register calling the text table. Also in Binary mode multiple text table entries can
be displayed the user can then scroll between these text table entries, or set the Auto Scroll option to let
the TIU to automatically scroll between all the selected entries.

8.4.3 To Edit a Bitmap table from the TIU20X:

1. Select the text string field by pressing the Pause key.
2. Move up or down the list using the Up and Down keys.
3. Press the Enter key to select the desired text string.

8.4.4 To Export/Import a Bitmap Table

a.  Export
1. Click the Export button.
2. Enter the location of the file.
3. Enter the name the file the text table is to be exported to.

Figure 8.9 – Sample Animated Bitmap Selector Table
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b.  Import
1. Click the Import button.
2. Click on the file to be imported.

8.4.5 Default Bitmap Table ID Entries
If an undefined value is entered into the Field ID table entry field (i.e., a value that has not been assigned
in any bitmap table), then one of two different things happen.

1. If the user has assigned a value to the Default Entry in the Text Table box, then that entry number is
displayed. This value is assigned by first checking the box next to Default Entry, then entering a
number in the box below.

2. If the box is unchecked and a default entry has not been selected, then a blank bitmap is displayed.

8.4.6 Draw Attributes
The properties or Attributes of a shape can be set before or after the shape is drawn.

Figure 8.9 Draw Attributes
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CHAPTER 9 : NETWORKING

9.1 Scope
The Operator Station (TIU) range supports 3 networking protocols. CsCAN, DeviceNet and Profibus. The
DeviceNet/CsCAN Operator Station options are TIU101/111/201. The Profibus Operator Station options
are TIU102/112/202. This chapter will explain how to configure the TIU units for network communication
and the registers used.

9.2 CsCAN
The CsCAN network is based on the Bosch Control Area Network (CAN) and implements a protocol
designed to take maximum advantage of the global data broadcasting capability of CAN.  Using this
network protocol, up to 64 Control Stations can be linked without repeaters, and up to 253 Control
Stations can be linked by using 3 repeaters.
The available registers are;

Table 9.1 – CsCAN Network Registers
Type Function Description Quantity Retentive
%AIG Network Analog Input Specially defined analog inputs that come

from the CsCan network protocol. Data is in
words.

32 No

%AQG Network Analog
Output

Specially defined analog outputs that go to
the CsCan network protocol. Data is in
words.

16 No

%IG Network Digital Input Single bit registers that come from the
CsCan network protocol.

64 No

%QG Network Digital Output Specially defined digital outputs that go to
the CsCan network protocol.

64 No

9.2.1 Sending Data to the CsCAN Network
The TIU101/111/201 units contain a special set of registers called Global Network I/O, or simply Global
I/O. Using the CsCan protocol these bits are automatically sent through the network to all other units on
the network. Anyone unit can be made aware of the activities of any other unit on the network, and any
one unit can send a signal to any or all other unit on the network.

The global ‘I’ registers contain an image of global ‘Q’ registers located in a different units connected to the
network. The association between I registers and ‘Q’ registers is set at the destination unit.
Any ‘I’ register may be associated to one and only one ‘Q’ register, but that ‘Q’ register may be located in
any other unit on the network. Any ‘Q’ register is broadcast on the network for any or all other units to
use.

9.3 DeviceNet
9.3.1 DeviceNet Features Supported Using Operator Station Modules
It is important to determine the features that the Operator Station Modules support (when used in a
DeviceNet network) before programming, configuring, and setting up the network.

9.3.2 Communication Method
Although the DeviceNet Specification provides for two methods of establishing communication, the
Operator Station Modules implement only one of the methods, which is referred to as the Predefined
Master/Slave Connection Set.  This method provides communications typically seen in a Master/Slave
relationship and uses a DeviceNet Master/Slave protocol.

The other method of communication is through the use of the Unconnected Message Manager
(UCMM).  The Operator Station Modules do not currently support the UCMM method of communication.
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9.3.3 Message Class / Message Priority
Both Explicit Messaging and I/O Connections are established using a message class known as Message
Group 2 Only. In this message class, the message priority is determined solely by the network address
of the individual nodes. The lower the node’s address, the higher its priority.

9.3.4 Types of Messages / Connections Supported
The Explicit Messaging and Polled Connection features are supported.  The following terms are
defined per the DeviceNet Specification, Release (2.0), Volume I: DeviceNet Communication Model and
Protocol.

Explicit Messaging: - Used in typical request/response-oriented networks.  Explicit Messages are used
to command the performance of a particular task and to report the results of performing the task.

Polled Connection: - Responsible for receiving the Master’s Poll Command and returning the associated
response.

Explicit Messaging is used for the transfer of small amounts of infrequently accessed data such as
configurations or tuning.

The Polled Connection is used for data that is sent automatically between the slave and the DeviceNet
Master (Scanner) without intervention. The DeviceNet Master sends a Polled Command to a DeviceNet
Slave. Attached to the polled command is 32 words of data for the TIU to use. The DeviceNet Slave
produces or sends a Polled Response back to the DeviceNet Master.  (The Polled Response consists
of 32 words of data.)  All Operator Station modules monitor (or eavesdrop on) Polled Response
messages on the network.

The Operator Station Modules do not currently support Bit Strobed, Cyclic and Change-of-State
connections.

9.3.5 Additional Feature available in Operator Station Modules
The Horner extension of the DeviceNet protocol known as Polled Snooping is also provided.  Polled
Snooping is totally non-intrusive to DeviceNet traffic.  The Operator Station Modules monitor (or
eavesdrop on) all Polled Response messages on the network.  The data in the Polled Responses can
used by the CBREEZE project in each of the Operator Station Modules.  Their projects can make
decisions based on the snooped data.

9.3.6 DeviceNet Requirements
The following requirements must be met to integrate Operator Station Modules into a DeviceNet network
and to establish communications with a DeviceNet Master.

a. DeviceNet Node Address (MACID)
In order to communicate with a DeviceNet Master, a unique MACID must be assigned to each node on
the network.  Valid DeviceNet MACIDs are within the range of 0 - 63 inclusive (at least one master and 63
slave and/or master nodes).

b. DeviceNet Baud Rate
Each device connected to a DeviceNet network must be configured to operate at the same baud rate.
The baud rate for the Operator Station Modules can be selected to be 125K, 250K or 500Kbaud.  All
devices on a DeviceNet must be configured to operate at the same baud rate.
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The available registers are;
Table 9.2 – DeviceNet Registers

Type Function Description Quantity Retentive
%AIG Network Analog

Input
Specially defined analog inputs that come
from the DeviceNet network protocol. Data is
in words.

32 No

%AQG Network Analog
Output

Specially defined analog outputs that go to the
DeviceNet network protocol. Data is in words.

32 No

9.3.7 Horner Extension Snooped Slaves
Most controllers that support DeviceNet slave networking communication allow snooping.  Snooping
allows the controller to gather data from other slaves on a network as the master polls that slave device.
Polled data sent from the slave to the master can be in one of two formats depending on the amount of
data the slave needs to send to the master.

9.4 Profibus
Available Registers

Table 9.3 – Profibus Network Registers
Type Function Description Quantity Retentive
%AIG Network Analog

Input
Analog inputs.
Data is in words.

32 No

%AQG Network Analog
Output

Analog outputs.
Data is in words.

32 No

%IG Network Digital
Input

Single bit input
register.

64 No

%QG Network Digital
Output

Single bit output
register

64 No

The Profibus utilise a Master-Slave type of communication with the TIUXX2 functioning as the slave
device. Up to 32 devices (Master or Slave) can be connected in one segment without using repeaters or
up to 125 devices can be connected using repeaters.

9.5 Configuring the TIU10X/11X/20X for Network Communication
9.5.1 Scope
The following procedure configures the Operator Station (TIU) to communicate on a CsCAN, DeviceNet
or Profibus network

1. Select the terminal type from the edit menu.
 

 Table 9.4 – Terminals Types
Part Number TIU Series Network Type
 TIU101  TIU100  CsCAN
 TIU102  TIU100  Profibus
 TIU103  TIU100  DeviceNet
 TIU111  TIU110  CsCAN
 TIU112  TIU110  Profibus
 TIU113  TIU110  DeviceNet
 TIU201  TIU200  CsCAN
 TIU202  TIU200  Profibus
 TIU203  TIU200  DeviceNet

 
2. From the main screen of the CBREEZE software select Network from the drop down Configuration

menu.
3. The Configure Network Screen will be displayed for the appropriate terminal type chosen in step 1.



PAGE 86                                                         06 Apr 2000                                     CH. 9: NETWORKING
GFK-1818

4. From the Configure Network screen select the node ID and the appropriate network protocol. If
CsCAN terminal type TIUXX1 is chosen then network protocol CsCAN is displayed. If Profibus
terminal type TIUXX2 is chosen then network protocol Profibus is displayed. If CsCAN terminal type
TIUXX3 is chosen then network protocol DeviceNet is displayed

5. Click On Enable Network.
6. Set the Node ID for the Terminal in the specified network.
7. Set the required Network Baud rate. For Profibus this is Auto Sensing.
The available Network Registers are displayed under Register Type Tabs on the Configure Network
Screen.

9.6 Programming Network Input
9.6.1 Network Input Registers IG & AIG
In terms of programming the Operator Station to receive data from the network, all input register are
treated as Internal Registers on the terminal and are none retentive.

9.6.2 Configure Network Input Registers
To configure any network-input register, simply specify the source of the data.
Profibus
Because Profibus is a Master-Slave type communication only, i.e. no slave can communicate with
another slave, the source of the data will always be the master device.
CsCAN
In CsCAN data is transmitted globally, therefore any other node on the network can be the source of the
data.
DeviceNet
In the DeviceNet network the master device decides what data is sent to each slave device. However with
the Horner Extension to the DeviceNet protocol, which allows each specified Snooped slave device to
snoop on other specified Snooped slave devices. Therefore in DeviceNet network the master or any slave
device that is specified as a Snooped Node can be the source of the data.

9.6.3 Configuring Network Input Registers for all Network Protocols
1. Choose the register type from the Configure Network window. Only available registers will be

displayed
2. Double click the specific register to be configured.
3. The Configure Network Input window appears.
4. In the Data Source Box click the enable tick box.
5. Enter the node ID and register number of the data source.
 
 This procedure will map the output registers from the data source into the input register of the Operator
Station. This data can then be sent to registers on a device connected to the serial port of the Operator
Station.
 
1. Click on the enable tick box in the Data Destination box.
2. Select the register type and the register location.
3. Chose the format of the data to be stored as.
If Transmission Timeout is not chosen then the data will be sent to the serial device every time the Input
Register is updated. Else the frequency of which the data is sent to the serial device may be specified in
100 msecs.

9.7 Programming Network Output
9.7.1 Network Output Registers QG & AQG
In terms of programming the Operator Station to send data to the network, all output register are treated
as Internal Registers on the terminal and are none retentive. The value contained in this Internal Register
is sent to the network. The network then reads this value the frequency of which depends on the type of
network and how the network is set-up.

9.7.2 Destination of Output Registers
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Profibus
Because Profibus is a Master-Slave type communication only, i.e. no slave can communicate with
another slave, the destination of the data will always be the master device.
CsCAN
In CsCAN data is transmitted globally, therefore the destination of the data depends on which node wants
the data, and is configured at the receiving node end.
DeviceNet
In the DeviceNet network the master device decides what data is sent/received from each slave device.
However with the Horner Extension to the DeviceNet protocol, which allows each specified Snooped
slave device to snoop on other specified Snooped slave devices. Therefore in DeviceNet network the
master or any device that is specified as a Snooped Node can be the destination of the data.

9.7.3 Mapping Output Registers QG & AQG to a Serial Device.
All output registers maybe mapped to a device connected to the serial port of the Operator Station. From
the Configure Network window chose the output register type to be mapped (QG or AQG). Double click
the specific register to be mapped. The Configure Network Output appears.
Click the enable option.
Choose the register type from the list of available registers from the data type pull down menu.
Type in the Location of the specific register.
Choose the format the register is to be stored.
Type in the frequency the data is to be mapped in 100 msecs.
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CHAPTER 10: MATHEMATICS

10.1 Scope
The TIU10X/11X/20X now contains a Mathematic Interpreter. Up to 1024 lines of Mathematic
Statements can be programmed into the terminal, and these can be split into function blocks which are
called by the system as required. The function blocks are called on any of the following basis...

Table 15.1 – Call Methods
Call Method Description
Background Tasks At regularly repeating intervals, definable down to 0.01

seconds
Scheduled Tasks At a particular time (HH: MM) on specified days of the week
Function Key Presses As function keys are pressed

10.2 System Registers
The available system registers are as follows: -

Table 15.2 – Register Names
Description Name Available

Bit Input SmartStack %I Only if SmartStack Configured
Bit Output SmartStack %Q Only if SmartStack Configured
Word Input SmartStack %AI Only if SmartStack Configured

Word Output SmartStack %AQ Only if SmartStack Configured
Internal Word Register Internal %R Only if Maths Configured

Internal System Register Internal %SR Only if Maths Configured
Internal Bit Register Internal %M Only if Maths Configured

Network Word Output Network %AQ Only if Network Configured
Network Word Input Network %AI Only if Network Configured
Network Bit Output Network %Q Only if Network Configured
Network Bit Input Network %I Only if Network Configured
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The Internal System Registers available are as follows: -

Table 10.3 – System Registers
Name Read / Write Description

%SR01 R/W Contains the current page ID
%SR02 R Contains the state of the up/down/pause/enter keys.
%SR03 R/W Contains the Global PLC Network Address
%SR04 R/W Contains the current password
%SR05 R Current edit variable

 0 = none being edited, 1  = first editable variable active,
etc.

%SR11 R Contains the RTC seconds
%SR12 R Contains the RTC minutes
%SR13 R Contains the RTC hours
%SR14 R Contains the RTC date
%SR15 R Contains the RTC month
%SR16 R Contains the RTC year
%SR17 R Contains the RTC number of days in current month
%SR18 R Contains the RTC number of the day in the year

                (eg. 1st February = 32)
%SR19 R Contains the RTC day of week
%SR21 R Contains number of accepted alarms
%SR22 R Contains number of unaccepted alarms
%SR23 R/W Contains the total number of attempts to the PLC (Writing

any values resets all comms counters)
%SR24 R/W Contains number of good comms transactions
%SR25 R/W Contains number of bad comms transactions
%SR26 R/W Contains number of no comms transactions
%SR31 R Can Status
%SR32 R Can Test Result
%SR33 R Can Off Count

10.3 Maths Functions
Maths functions may be used for a variety of purposes.
1. Maintaining Internal Variables
2. Controlling Database Operations
3. Generating Alarms

10.4 Execution of Maths Functions
Maths functions are called by starting at a specified line. The lines are processed consecutively beginning
at the start line until a line with a *END* marker is processed, or the end of the maths listing is reached.
Control may be switched using a GOTO statement in the function block or using any of the conditional
statements, which will jump to another line or END marker.

10.5 Mathedit Windows Application
To view and modify the contents of the Mathedit Application, click the mathematics icon from the tool bar

, or choose Maths from Configure in the main menu, the Mathedit Application window appears (Fig
10.1).
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10.6 Opcodes

The available operational statements are: -

1. No Operation 

2. Conditional 

3. Assignment 

4. Bit Operation 

5. Table Operation 

6. Function 

7. Control Flow 

8. Set End 

10.6.1 No Operation

This statement causes the line to do nothing. The statement shows as a blank line.

10.6.2 Conditional

This statement compares the contents of a local store register with either the contents of another local
store register or a constant. After which an action is completed, depending on the result of the
comparison.

The available Comparison Tests are:

1. Equal 

2. Not Equal 

Figure 15.1 – Mathedit Application Window
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3. Less Than 

4. Less Than or Equal 

5. Greater Than or Equal 

6. Greater Than 

7. And 

8. Or 

Conditional Action
If the result of the test is true than the chosen action is executed.

Note: The And and Or statements are true if the result equals not zero.

1. Set Bit
Sets the bit in the specified Local Store Bit Register.

2. Terminate Function
Terminates the function. An End statement is put at the end of the line statement.

3. Jump To Line.
Jump to specified line number or End

Figure 15.2 – Conditional Statement
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10.6.3 Assignment

This statement assigns a value to the specified local register. The value of the register can be
mathematically manipulated before storing it the local register.

The available mathematical functions are: -

1. Equal
This function makes one Register equal another register.

2. Plus
This function lets the programmer add the contents of a register to the contents of another register or
constant and stores the result in the specified register.

3. Minus 
This function lets the programmer subtract the contents of a register or constant from the contents of a
register and stores in the result in the specified register.

4. Multiply 
This function lets the programmer multiply the contents of a register by the contents of another register or
constant and stores the result in the specified register.

5. Divide 
This function lets the programmer divide the contents of a register by the contents of another register or
constant and stores the result in the specified register.

6. Percentage
This function divides one integer register by the contents of another register or by a constant, and stores
the remainder in the specified register.
E.g. register 100 contains 18
If %R101 = %R100 % 7 Then %R101 = Reminder(100 / 7) = 2.

7. And
This function lets the programmer AND the contents of a register with the contents of another register or
constant and stores the result in the specified register.

Figure 10.3 – Assignment Statement
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8. Or
This function lets the programmer OR the contents of a register with the contents of another register or
constant and stores the result in the specified register.

9. Exclusive Or
This function lets the programmer XOR the contents of a register with the contents of another register or
constant and stores the result in the specified register.

Note: Indirection is allowed on the %R local registers, e.g. %R10 = %R(%R40) + %R(%41). If %R40
contain 100 and %R41 contains 11, then %R10 will be sum of the contents of %R100 and %R11.

10.6.4 Bit Operation

This operational statement can perform 4 different operations on a local bit register.

1. Set
Changes the bit value to 1

2. Clear
Changes the bit value to 0

3. Invert
Changes the bit value to 1, if present value is 0, or changes the bit value to 0, if present value is 1.

4. Pulse
Sets the specified bit high for 1 second and clears it to go low.

Figure 10.4 – Bit Operation Statement Window



CH. 10: MATHEMATICS                                 06 Apr 2000                                                         PAGE 95
GFK-1818

10.6.5 Table Operation

This operation statement performs a number of operations on a specified table. As per figure 10.5 the
table definition is defined as the number of local registers in the table beginning at the specified local
register.

The available operations are:

1. Total
This action sums the contents of the registers and stores the result in the target register.

2. Average
This action averages the contents of the registers and stores the result in the target register.

3. Maximum
This action searches the contents of the registers and stores the maximum value in the target register.

4. Minimum
This action searches the contents of the registers and stores the minimum value in the target register.

5. Move To
This action moves the contents of the registers in the table as a memory block, to a memory block
beginning at the target register

6. Swap With
This action moves the contents of the registers in the table as a memory block, with a memory block
beginning at the target register

7. Reset
This action resets the contents of each of the registers in the table to zero.

Figure 10.5 – Table Operation Window
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10.6.6 Function

This action performs a function on the contents of the specified action and stores the result in the same
register or another specified register. The available functions are: -
Root
This function puts the square root of the contents of the first register in the second specified register.

ToBCD
This function converts the contents of the first register to Binary Coded Decimal and stores it in the
second specified register.

FromBCD
This function converts the contents of the first register from Binary Coded Decimal and stores it in the
second specified register.

10.6.7 Control Flow

This action allows the programmer to perform simple program flow commands within the mathematic
function. The available commands are: -
1. Pause
This command allows the programmer to pause the mathematic function for a specified number of
seconds.

2. Goto
This command allows the programmer to jump to a specified line number of the end of the function.

3. Gosub
This command is similar to the Goto command however when an End command is reached the program
flow returns to line immediately after line where the Gosub command was executed.

10.6.8 Set End

This action denotes the end of a mathematic function.
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10.7 Background Functions
The OS’s background function facility allows the terminal to continually run up to 8 maths functions
automatically, without operator intervention. These functions can be programmed to run repeatedly after a
specified time interval or be executed once on initialisation of the terminal.
To program a background function, choose Background Functions from Edit menu, in the Mathedit
Application Window. Figure 10.6 shows the background function set-up window.

10.7.1 To Program a Background Function
Enable one of the 8 background functions by clicking in the tick box next to the number of the background
function.
1. Click Restart Function if the function is to be executed only on initialisation of the terminal.
2. In the Seconds field specify the time interval between executions of the function.
3. In the Call field, specify the function to be called, this is the line number where the function begins.

Figure 10.6 – Background Function Set-up Window
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10.8 Schedule Functions
Scheduled Functions have been provided as a means of initiating functions on a time and day basis.
There are 16 schedules available each of which specifies a time of day and day of the week at which a
Maths Function is to be called.

To configure the scheduled functions for the TIU terminal select Scheduled Functions from the Edit menu.

10.8.1 To Set-Up a Schedule Function
1. Enable the schedule by clicking on the tick box corresponding to the schedule number.
2. In the Time enter the time of day at which the function is to be executed.
3. Click the day or days on which the function is to be executed.
4. In the Call field enter the mathematic function to be executed, this is the line number of the

mathematic function.

10.9 Data Transfer Block
Local registers in the terminal can be mapped to registers in the automated equipment using the Data
Transfer Block facility. The maths feature only allows internal data to be accessed. This is because it is
not practical to continually fetch data from and send data to the AE as required whilst the maths is
executing. In order to fetch data from the AE and Send data to the AE from internal registers it is possible
to map blocks of data to and from the %R blocks to the AE. Data blocks may be read at a fixed interval

Figure 10.7 - Schedule Functions Window
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and data is written to the PLC whenever a value within the block changes. Maximum number of transfer
blocks is 64.

10.9.1 To Add a Block Transfer
1. From the Edit menu choose Data Transfer Block.

2. Click on the Add button to add a Map Register Statement. Figure 10.9 illustrates the how the
registers are mapped.

3. Enter the Data Type Register and Location of the AE registers.
4. Enter the block size or the number of registers to be mapped.
5. The registers maybe mapped in two directions, from the terminal to the AE or from AE to the terminal.

Choose which transfer direction.
6. The Period is the time interval between data transfers. In the Period field enter how often the data is

to be transferred.
7. Finally enter the first local register where the data is to be transferred to or transferred from.

Figure 10.8 – Data Transfer Block
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Figure 10.9 – Mapping PLC Registers and Local Registers
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CHAPTER 11: SMARTSTACK 

11.1 General
Now added to the TIU200 are the SmartStack  modules from the OCS Range. The SmartStack system
is a method of allowing I/O expansion on an HMI. A wide range of modules is available including Digital
and Analogue.

11.2 Installing and Removing a SmartStack Module
The following section describes how to install and remove a SmartStack Module.

Caution:   To function properly and avoid possible damage, do not install more than four
                  Smart Stack  Modules per TIU20X.

a. Installing SmartStack Modules
1. Hook the tabs.  Each SmartStack Module has two tabs that fit into slots located on the TIU20X.  (The

slots on the TIU20X are located on the back cover.)
2. Press the SmartStack Module into the “locked” position, making sure to align the SmartStack Module

fasteners with the SmartStack receptacles on the TIU20X.

b. Removing SmartStack Modules
1. Using a Flathead screwdriver, pry up the end of the SmartStack Module (opposite of tabs) and swing

the module out.
2. Lift out the tabs of the module.

Figure 11.1 – Installing a SmartStack  Module in an OCS.
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11.3 Configuring SmartStack Module
At this time the range of compatible SmartStack modules for the TIU range is as follows: -

Table 11.1 – SmartStack Modules
Module Description

IC300ADC110 4 channel Analog Inputs, Voltage (0-5vdc, +/-5vdc, 0-10vdc,
+/-10vdc), 12 bit

IC300ASC100 ASCII BASIC: 3 ports, 64K program memory
IC300DIQ511 4 Channel 12/24 Vdc Digital Input Pos/Neg logic 4 Channel

12/24 Vdc Digital Output Neg logic
IC300DIQ512 4 Channel 12/24 Vdc Digital Input Pos/Neg logic 3 Channel

Relay Output
IC300DIQ522 4 Channel 120 Vac Digital Input Pos logic 3 Channel Relay

Output
IC300DIQ611 8 DC Inputs (12/24vdc, pos/neg logic), 8 DC Outputs

(5/12/24vdc, 0.5A, neg logic)
IC300DIQ612 8 DC Inputs (12/24vdc, pos/neg logic), 6 Relay Outputs

(250vac, 30vdc, 4.0A)
IC300DIQ622 8 AC Inputs (120 vac), 6 Relay Outputs (4.0Aper point)
IC300MIX11 2 Channel voltage (+/- 10vdc) Inputs

2 Channel voltage (+/- 10vdc) Outputs

Click on the SmartStack Configuration icon or choose SmartStack I/O from the Configuration menu.
From the Configure SmartStack I/O window, click on the pull down menu for the appropriate slot.
The available modules are listed, choose the module to be installed.

NOTE: - After the project is downloaded to the TIU20X, on power up the TIU checks if the specified
SmartStack module is inserted. If the module is not inserted the TIU will display “SmartStack I/O Error”.
Power down TIU and insert specified SmartStack module.

Figure 16.2 – SmartStack Configuration
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11.4 SmartStack I/O
The input and output of the SmartStack is handled within the local registers of the terminal. The local
registers and therefore the I/O of the SmartStack is then analysed or manipulated within the Mathedit
Application of the CBREEZE software. See chapter 10 for more information on the Mathedit Application.

11.5 Module Addressing
The base addressing for the slots are as follows: -

Table 11.2 Base Address
Slot Base Address

1 00001
2 10001
3 20001
4 30001

The input and output register names and addresses are as follows: -

Table 11.2 I/O Address
I/O Type Address
Bit Input %Innnnn

Bit Output %Qnnnnn
Word Input %AInnnnn

Word Output %AQnnnnn
v nnnnn = the base address of the module
v The base address begins at nnnnX and is incremented by 1 to the

last channel on the module. (X = 1 or 0 depending on the bit base
numbering set-up under Configure/Bit Base Numbering, default is 1)

All examples below assume Least Significant Bit for Internal References is set to 1.
E.g. the third bit of a Digital Input module in slot 3 would have the address of  %I20003.
E.g. the fourth bit of a Digital Output module in slot 3 would have the address of  %Q20004.
E.g. the third channel of an Analogue Input module in slot 4 would have the address of  %AI30003.

Note: Digital Input modules can be read as words or bits by selecting the appropriate register type. Digital
Output modules can be written to as words or bits by selecting the appropriate register type. The system
will strip off any redundant bits within the word.

11.6 Displaying Data From SmartStack
Data from SmartStack modules can be embedded into a menu page in exactly the same way as other AE
devices. Embed the data type as normal and select the Location from the range of “Smart I/O” register
types shown in the pull down register table. The normal function can then be applied to the register value,
i.e. Range Checking, Scaling etc.

Note: The numeric default settings for Analogue modules should be set to 16 bit and signed.
Output data can be edited / scaled using the screen editor in the same way as a normal AE.
Data to / from SmartStack can also be scaled or manipulated via the Maths.

Note: The numeric default settings for Analogue modules should be set to 16 bit and signed.
Output data can be edited / scaled using the screen editor in the same way as a normal AE.
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It is not possible to read and then modify Output types directly within a TIU system.  If it is necessary to
do this, it is better to use a System %R register within the Maths facility to manipulate and hold the
“master value” then assign the actual value to a %AQ register. See Chapter 10 Mathematics on writing
and calling maths functions.
Again, it is good practise to write to an Output type at only 1 point in the configuration.

11.7 Considerations for Shutting Down & Restarting a TIU20X with I/O
 During a “shutdown” for downloading, it is possible to leave SmartStack outputs on. It is therefore
important to make sure that all outputs are in a safe condition before this operation is carried out.
For example, this could be implemented using a dedicated Function Key labelled SHUTDOWN to call a
Maths function that set any SmartStack outputs to a safe state for shutdown.

During a restart either from a “Power Up” or from after a download, SmartStack outputs may not always
be in the mode required. This situation could be overcome by calling a Restart Maths function to correctly
initialise the SmartStack output modules.
Examples are shown below

Figure 11.3 – Math Example Word Output

Figure 11.4 – Math Example Set Outputs for Power Down

Figure 11.5 – Calling Math Function From Function Key

Figure 11.6 – Calling Math Function from Background Function



INDEX                                                             06 Apr 2000                                                       PAGE 105
GFK-1818

INDEX

Aalphanumeric Data, 29
Analog Meters, 35
Assignment, 93
Auto Mask Bit, 38
Background Functions, 97
Bit Operation, 94
Bit Status, 31
Character Generator, 47
Character Set, Download/Upload, 21
Clock Calendar, 39
Communications, Proving, 14
Configuration

All Network Protocols, 86
Control Data from Remote Device, 46
Control Flow, 96
CsCAN, 83
Data Indirectly Specified, 46
Data Transfer Block, 98
Default Page Type, 20
Default Text Table Entries, 38
Deleting Page, 21
DeviceNet

Baud Rate, 84
Features Supported, 83
Message Class/Priority, 84
Messages / Connections, 84
Node Address (MACID), 84
Requirements, 84

Draw Mode, 73
Editing a Character, 48
Embedded Data

Scope, 27
Enable Axes, 45
Execution of Math Functions, 90
Explicit Messaging, 84
Export/Import Text Table, 38
Firmware Upgrade, 9
Flashing Characters, 42
Font Size, 21
Function, 96
Function Keys, 22
Graph, Embed, 44
Graphic Editor

Scope, 73
Graphic Menu Page

Embedding Data, 78
Graphic Page, 21
Graphing, 43
Horner Snooped Slaves, 85
Icon Descriptions, 15
Ingredient Properties, 52

International Keyboards, 49
Key Mapping, 21
Mapping, Clock Calendar, 40
Math Functions, 90
Mathedit Windows Applications, 90
Mathematics

Scope, 89
System Registers, 89

Menu Timeout, 41
Network

Configuration, 85
Mapping Output Registers, 87
Programming Network Input, 86
Programming Network Output, 86

Networking
Scope, 83

New Page, Inserting, 20
Numeric Data, 28
Opcodes, 91
Operating System, Updating, 19
Page Wizard, 43
Password Protection

Sub-menus, 33
Polled Connection, 84
Polled Snooping, 84
Printing, 20
Profibus

Registers, 85
Project

Creating, 17
Downloading, 18
Opening, 18
Saving, 18
Updating, 19
Uploading, 18
Verifying, 18

Real-time Clock, 42
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SmartStack
Configuration, 102
Displaying Data, 103

Software Upgrade, 9
Special Character, 47
Static Bitmap Mode, 75
System Variables, 33
Table Operation, 95
Terminal Type Selection, 21
Test Page, 21
Text Selector, 36
Text Tables, 36
Time Base, 46

Timers, 30
Editing, 31
Monitoring, 31

TIU Terminal, 17
Trend, Embedding, 46
Trending, 45
Tutorial, 57

Alarms, 69
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Password-Protected Sub-Menus, 63
Status, 65
Sub-menus, 60
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